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1 Welcome

Thank you for purchasing easyDCP Creator software.

With the easyDCP Creator software you are now able to create DCPs in a fast
and easy way. In the easyDCP Creator you are able to create stereoscopic and
encrypted DCPs.

With easyDCP Creator it is possible to create SMPTE compliant DCPs or J2K

Interop DCPs. This software solution needs only a standard PC/Mac to make
either 2k or 4k content ready for the distribution to a digital movie theater.

There is no special or additional hardware necessary.
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2 Feature Overview

The feature of easyDCP Creator+ are:

easyDCP
Feature Creator+ easyDCP
Creator+
Demo
SMPTE and Interop compliant DCP creation v v
Stereo, 5.1 and 7.1 Surround Audio v v
DPX, TIFF and JPEG 2000 Input v v
Automatic Gamut Transformation from ITU709 to XYZ v v
SMPTE & Interop compliant Subtitles v v
Metadata adjustment (e.g. Offset, Entry Point, Duration, Content v v
Titles, Content Types, Annotation Texts)
Graphical User Interface with Drag and Drop v v
Windows and Mac OS Version v v
Dolby Atmos (packaging only) v v
QuickTime Input v v
Loading DCPs v v
3D-Support v v
Encryption and Signature X v
Scriptable v v
Supplemental DCPs (DCPs with referenced MXF tracks) v v
Loading Key Delivery Messages (KDMs) X v
Available for 64 bit Windows 10 v v
Available for 64 bit Mac OS X (10.14-10.15) v v

6 of 105

easyDCP Creator User Manual




3 Licensing

3.1 License Activation and Certification

Download easyDCP Creator+ at www.easydcp.com.

3.1.1 Offline workflow

After installing and starting easyDCP Creator+ the following dialog appears:

@ a5y 0CP Creators X

‘ L easyDCP Creator+ 4.0.0

Legin

Demo / Offline Mode

Click “Demo / Offline Mode” to start a free version of easyDCP Creator which
is subjected to the demo mode restrictions. After startup has finished, open the
options dialog, select “Activation Status” and press “Request License &
Certificate”. Fill in the licensee’s name, the URL that shall be stated in the
custom server certificates and a password that is used to protect access to the
certificates. If the computer is connected to the Internet, click the “submit”
button. The default web-browser will open www.easydcp.com, where further
instructions will guide you through the purchase process.

After the purchase, a link to the zip file with the License & Certificate will be
available for download within your user account at www.easydcp.com. The zip
file can be dragged & dropped into easyDCP Player+ installation to unlock it.

The procedure is also described in a screen cast at www.easydcp.com.

Please be aware that this workflow only works with permanent licenses. For
subscriptions you have to follow Online workflow.
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3.1.2 Online workflow

Purchase one of the available subscription plans at www.easydcp.com. After
the purchase, a license and the necessary certificate for easyDCP Creator+ is
linked to your easyDCP account.

@ <25/DCP Creator+ x

‘ L easyDCP Creator+ 4.0.0

Login

Demo / Offline Mode

Install and start easyDCP Creator+ and fill in the username and password
you've used for your easyDCP account. After clicking “Login”, easyDCP
Creator+ will automatically download the linked license and certificate from
www.easydcp.com and activate your instance.

The “Device Name” field is prefilled with the name of the machine you use
easyDCP Creator on. You can change the name freely. The name will be send
to easyDCP.com and is used for convenient device identification only.

Please be aware that a permanent internet connection is required. As soon as
easyDCP Creator+ detects a connection loss, the graphical user interface will
be locked until the internet connection has been re-established.

With the online licensing workflow it’s possible to run easyDCP Creator+ on
different systems with the same license. Please be aware that multiple
subscriptions are necessary to run easyDCP Creator+ instances at the same
time on different machines.

Please be aware that for each computer a server certificate will be generated.
Example: If you login on system 1 and afterwards on system 2, there will be
two server certificates linked to your easyDCP account.
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3.2 View current license status

To view the license details with an offline license, go to “menu bar -> File ->
Settings -> Activation Status” and select Details next to the “Licensee” entry.

3.3  Application Data and Settings

easyDCP Creator automatically creates an application data folder. It contains
the settings file as well as a folder where the server certificates are stored and a
repository for color transform files.

The folder is located at
<User Application Data>/Fraunhofer IIS/easyDCP Creator+/

Additionally, all easyDCP applications share a folder with additional files such as
color space descriptions. It is located at
<User Application Data>/Fraunhofer IIS/easyDCP Shared/

The user application data folder on Windows is located in
C:/Documents and Settings/<username>/Application Data/

A shortcut is to just enter $APPDATA% into the address bar.

On Mac OS X, the user application data folder is at
/Users/<username>/Library/Application Support/

3.4  Software Update

Please make sure you leave the automatic check-for-updates enabled, so that
you get informed immediately when new versions are available for download.

Multiple versions of easyDCP Creator can be installed side-by-side, so there is
no need to uninstall the old version before installing a new one.

With an active subscription it is possible to just login in the new version without
further action required.

A new license file is only required for major updates, e.g. version 4.0 to version
4.1, and can be purchased at www.easydcp.com. Point releases do not require
a new license, e.g. 4.0.0t0 4.0.1.

The update procedure is as follows

Point Release (only the last version number changes, e.g. 4.0.0 to 4.0.1)

1. Log into your account at www.easydcp.com

2. Download the new installer file and install it
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3. Offline licensing workflow: The new easyDCP Creator+ version will
automatically detect your existing license file and is good to go.

4. Online licensing workflow: easyDCP Creator+ will automatically
download the necessary license and certificate information from
www.easyDCP.com as described in 3.1.2. There is nothing else you
have to do.

Major Release (first or second version number changes, e.g. 4.0.x to 4.1.x)

Offline licensing workflow

1. Log into your account at www.easydcp.com and purchase the license
for the new version. The installer is then available for download.
Download and install it.

2. Open the new easyDCP Creator+ version and proceed with the steps
described in 3.1.1

a. If you have already used easyDCP Creator+ before, you likely
already have personalized server certificates. easyDCP Creator +
will prompt you for the password. If the password can be
verified, the new version of easyDCP Creator + will continue to
use your existing server certificates and only request a new
license file (the next step will prompt for a server certificate URL
and password anyway, but the inputs are ignored then).

Online licensing workflow

If you have a valid subscription plan the installer of the new version can be
downloaded at www.easydcp.com. All further steps are described in 3.1.2.
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4 QGetting Started

4.1 Project Configuration

At the start of easyDCP Creator or when creating a new project, the “Create
New Project” dialog pops up. It is used to set the initial configuration of your
project.

# Create New Project

Project Name:

My

Variant: SMPTE 429

Edit Rate: 24 fps

Create Open «

Project Name — Name of the project that will be used as title of the package
and the first composition. The project name can be changed later on.

The Project Name is limited to 14 characters and may not contain any spaces
or underscores to be compatible with the ISDCF Digital Naming Convention
used by easyDCP Creator.

Variant — The variant defines the specification the DCP shall meet. Now
InterOp, SMPTE 429 and SMPTE RDD 52 (Bv2.1 Application Profile) are
supported. We recommend either SMPTE RDD 52 or SMPTE 429. This can be
changed later.

Edit Rate - Should match your input material’s native edit rate as easyDCP
Creator will not adjust your input material to the selected edit rate. There is
only an edit rate conversion for the audio files if your input material has a
different edit rate. The edit rate cannot be changed after the project was
created.

Since version 4.1 easyDCP Creator supports mixed 2K/4K and 2D/3D DCP.
Therefore, Project Type selection to choose between 2K/4K/3D project type
was removed. The type is now set directly per Picture Track.
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Click Create to create the project. To access the project configuration after the
project was created, select “File -> Project Configuration..” from
the menu.

4.1.1 Digital Cinema Naming Convention

In digital cinema, it is common practice to follow a certain naming convention.
The most important attributes such as the resolution, language, audio layout
and so on are coded into the title so that a projectionist can later see them at
first glance. This technique is called Digital Cinema Naming Convention.

easyDCP Creator+ provides an editor that helps you put together a proper title.
The title will be used both for the project and also for the DCP and its
Composition Playlist. Please note that it's not mandatory to fill in all fields.

_FTR_ F _EN-XX_INT_51_2K_ 20201209 _

Film Title  TEST

For mi Save

To change different properties you can select them at the top by clicking on the
entry. This will open the edits for the selected group.

This dialog tries to fill out as many entries as possible automatically. Values
like Content Type, Standard and Package Type are derived from the current
project, but can be overridden manually.

All values are compliant to the Digital Cinema Naming Convention, Version V.9
(see http://www.digitalcinemanamingconvention.com).
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4.2 The Main Window

After creating a new easyDCP Creator project, the start-up screen comes up:

Main Menu

Composition and
Reel
Manager/Timeline

3 Picwre 4} Sound (3 Subtitles

¢
easyDCP Plus

Track Manager Track/Reel Preview Metadata Window

The main window is divided into several sub windows like a Track Manager and
a Reel or timeline window. The following sections explain how to use the
windows and features.

Per default the reel view is used, but it can be switched to timeline in the
settings (New Project Defaults => Uncheck “Use Reel View for DCP").

4.3 Packing List (PKL) Parameters
Each DCP has a packing list (PKL) that lists all files contained in the DCP as well

as some top-level metadata such as the creator, issuer and annotation text. The
PKL's annotation text can be regarded as the DCP title.
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To edit the packing list parameters, click the edit-icon in the main tool-bar
below the menu bar:

[# TEST_FTR_F_EN-X3{_INT_51_2K_MULL : 209_NUL_SMPTE_OV DCP (5M

Trag

E Annotation Text  R_F_EN-CCINT_51_2K_NULL 21 09_NUL_SMPTE_OV

Creator

Issuer Fraunhofer IS

4.3.1.1 Annotation Text

4.3.1.2 Creator

The Annotation Text appears on the screen if a volume (e.g. USB-Drive, Hard
disc Drive) is connected to a digital cinema system before ingest. This
annotation text can be regarded as the DCP title. For DCPs that only contain a
single Composition, it is common to use the same title for both the PKL and

CPL. The title should follow the digital cinema naming convention. For more
details, please refer to chapter 4.1.1.

The symbol next to the line edit to enter the name allows synchronizing the
package title with the composition. If the chain is connected, updates will also

update the name of the first composition. The same vice versa happens when
updating the composition content title.

[# TEST_FTR_F_EN-XX_INT_51_2K_NULL_20201209_NUL_SMPTE_OV DCP (SMPTE)

Trag

E- Annotation Text  X_INT_! 20 209_NUL_SMPTE_OV ... | S T KNULL v IH ‘> & %

If this package conains only one CPL, also update its title

Fraunhofer IS

This synchronization mechanism is also available for Tracks to have a
consistent annotation text and also for Creator and Issuer of PKL and CPL.

Commonly, the application that was used to create the DCP is stated here. This
field is informational only and may be displayed by several D-Cinema servers.

The Creator is automatically filled with the easyDCP Creator version used for
generation.
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4.3.1.3Issuer

4.4

441

Settings

State your company name here. This field is informational only and may be
displayed by several D-Cinema servers.

With the settings you are able to set up default values for new projects, image
processing and file naming options.

To set up settings, gotto “File -> Options”

A new dialog will appear to set up the options described in the following
chapters:

New Project Defaults

Default project settings are automatically applied when creating a new project.
You can set your own company name as the issuer or a default Composition
Playlist (CPL) content kind (e.g. feature, trailer etc.). It's also possible to change
the default project type from SMPTE to InterOp.

The Use Reel View for DCP options defines the default view to be used when
starting easyDCP Creator. When checked it will use the reel view that has
always been present in easyDCP Creator. When unchecked the timeline view
introduced in easyDCP Creator 3.5 will be used.

No matter of the default setting, the view in use can be toggled at any time
during the workflow using the View menu in the menu bar and toggling the
Timeline entry or by pressing Ctrl + T.
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@ options X
Locati

Default Issuer: Fraunhofer IIS

Default CPL Content Kind: feature

Default Conformity: SMPTE

0K Cancel

These settings are default values that will be applied to new projects only.
They will not be applied to the current project.

Exception is the “Use Reel View for DCP" option which just requires a restart
of the easyDCP Creator to take effect. To switch between timeline/reel view
during runtime check the info box above.
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4.4.2 Track Defaults

Default Track settings are automatically applied when adding new Tracks to a
project.

@ options x

Default Outline Width: 9,0 %

4.4.2.1 Common Defaults
Default Outline Width
The outline thickness for timed text is not defined in the specifications. With

this setting, the default outline thickness can be configured and will be applied
to new Timed Text Tracks.

This setting only affects the way timed text is rendered in easyDCP Creator.
Unless timed text is burnt into the images, this setting will not affect how a
cinema server renders the outlines.

Timestamp to Frame Index Rounding Function

The rounding mode influences in some cases at which exact frame index a
subtitle appears or disappears.
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4.4.2.2 DCP

This setting only affects the way timed text is rendered in easyDCP Creator.
Unless timed text is burnt into the images, this setting will not affect how a
cinema server renders the timed text.

Fallback to System Font when Characters are missing

If characters are missing in the loaded font and this option is enabled, missing
characters will be replaced with characters from a similar font.

This setting only affects the way timed text is rendered in easyDCP Creator.
Unless timed text is burnt into the images, this setting will not affect how a
cinema server renders the outlines.

These settings are default values and will be applied to new Tracks only. They
will not be applied to already present Tracks.

Default Color Transformation

Specify here which default source color space or color transform should be
assumed for new Picture Tracks. The destination color space when selecting
“Color Spaces” always is XYZ.

The "QOverrides auto-detected color spaces” option disables auto-detection
of color spaces and will always use the configured Source Color Space. When
disabled the selected Source Color Space is chosen when the color space
can't be determined automatically.

Default Letterboxing
Specify here which letterboxing mode, if any, should be used for new Picture

Tracks. If “Automatic” is chosen, easyDCP Creator will choose a best fit for the
project type and the input material.

These settings are default values and will be applied to new Tracks only. They
will not be applied to already present Tracks.

Sign Language Code

Specify here which language the default for the sign language tracks shall be.
This settings effects only sound tracks containing sign language.
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Default language empty subtitle

Specify the default language being used for new empty subtitles. It is possible
to specify the language separately for InterOp and SMPTE subtitles.

Burn-in subtitle color space

Specify the default color space used for subtitles that get burned-in. They will
be converted from the source color space to XYZ during burn-in.

These settings are default values and will be applied to new Tracks only. They
will not be applied to already present Tracks.

@ options X

Standard RGB (sRGB)

O Overrides auto-detect:
Default Letterboxing

Automatic

Default language empty subtitles

InterOp:  English

0K Cancel
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4.4.3 Package Generation

With the package generation options you are able to modify the way images
will be processed during DCP generation.

General

[0 Use CPL metadata

n Threadripper 2950 16-Core Processor

Restore Default

(=14 Cancel

Use CPL metadata

SMPTE DCPs can contain additional metadata in the CPL. Enabling this option
will add these information some servers might show then.

CPU/GPU Encoding

Choose whether you want to use the CPU or GPU for encoding of the JPEG
2000 images.

GPU encoding is only available on Windows.
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4.4.4 File Naming

In the File Naming pane, you may specify how the files of a generated DCP
shall be named. When ingesting a DCP into a cinema server, the file names are
often not even displayed, but only the Composition Content Title. Adjusting
the naming scheme is optional.

There are two presets available, but it's also possible to define your own file
naming presets.

UUID - By default, the names of all generated files (except VOLINDEX and
ASSETMAP) are composed of its UUID and default suffix, e. g. “CPL_feae1e80-
0760-4c0f-a806-53414bcc8dab.xml” or “2a3d577d-0ace-482a-bb60-
61b5ebbd5bad_j2c.mxf”.

Content Title - The names of all generated files (except VOLINDEX and
ASSETMAP) are composed of its Content Title, Reel number, UUID and default
suffix, e. g. “CPL_MovieTitle_TRL1_3D_48_F133_0V_feae1e80-0760-4c.xml”
or "MovieTitle_TRL1_3D_48_F133_0OV_Reel1_2a3d577d-0ace-48_j2c.mxf".

Custom — When this preset is selected, you can customize your own file
naming via the placeholders shown in the usage.

. Options X

File Naming

P
uuID

Metadata Files:

Key Delivery Message (KDM) Files:

Date / Time:

Cancel
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4.4.5 Preview

In the Preview pane you can select the Color Space that will be used for the
thumbnails in the timeline as well as the preview. If a color transform isn’t
available from the source to the timeline color space, the source color space
will be shown.

@ options X

General

ct Defauls

Color Space Standard RGE (sRGE)

0K Cancel
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4.4.6 Activation Status

In the Activation Status pane you see all your license and certificate
information. You can see the Licensee and the certificates in the upper area
and show the details by clicking the “Details...” button next to them.

A new license or certificates can be requested and imported using the “Request
License & Certificates” and “Import License & Certificates” buttons.

Activation Status in only available in Demo mode and when importing an

offline license.

Activation Status

{unlicensed)

(no certificate found)

License and Certificates
Get Machine System Hash
Request License & Certificates
Import License & Certificates
Export License & Certificates

Remove License & Certificates

Es Browseto Signer Certificates folder
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Details...
Details...
Details...

Signature Setup

Signature Setup

Bs Browse to Server Certificates folder

[ Export Server Certificates
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4.4.7 Weblicensing

In the Weblicensing pane signature can be set up and server certificates can be
exported.

Weblicensing in only available in online mode.

@ options X

Certificates

[ Export Server Certificates

Signature Setup

0K Cancel
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4.5 Undo/Redo functionality

Starting with easyDCP Creator 3.8 it is possible to revert/redo changes done to
the project. Undo is triggered with Ctrl/Cmd + Z, redo with Ctrl/Cmd + Y. It's
also possible to use the Ul for it. There you find the option in the Edit menu.
That will also show you which action will be reverted/redone.

Below you can find lists of covered and uncovered features.

Covered functionality:

Changing PKL/CPL title

Changing issuer

Changing issuer language

Changing CPL content kind

Timeline

O

Adding clips

Removing clips

Moving clips

Split

Insert

Add Silence Sound Track
Add Empty Subtitle
Pre-/append Black Frames
Switching composition

Adding/removing compositions

Track Manager

O

Adding/removing tracks to/from the track manager
Changing track annotation text
Changing letterboxing

Changing color space/transform
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o

Changing supplemental state
Changing encryption
Changing subtitle burn-in state
Changing subtitle display type
Changing sign language

Changing audio configuration

e Compositor

o

o

Adding/removing tracks
Moving reels

Adding/removing reels
Adding/removing compositions

Duplicate Reel

Uncovered functionality:

e Compositor

o

Changing offset/duration of tracks
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5  Track Manager

On the left side of the main window you can find the Track Manager. Content,
which should be part of a package, must be added to this Track Manager first
in form of Tracks.

A Track is the smallest building block of a DCP and represents either

e an image sequence

e animage still picture (which gets internally multiplied for a given
duration)

e asound Track comprised of either a multi-channel audio file or a
multiple mono-sound files (or a combination thereof)

e or timed text (Open/Closed Subtitles/Captions).

Tracks

[} Picture o} Sound (3} Subtitles

Tracks are just references, “pointing” at the original source files. Do not move
or rename the source files after you have imported them. Each Track that is
used in at least one Reel will become a single file in the created DCP. Tracks
may have a description (i.e. Annotation Text) and a specific encryption key.
Tracks that are not used anywhere will automatically be omitted.

When you have a DCP with many Tracks, it is convenient to search for a Track
by title or by type using the bar at the bottom:
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5.1 Picture Tracks
5.1.1 Add Picture Track

To add a picture sequence to the Track Manager, just click the “Picture” button
at the top of the Track Manager or simply drag and drop files onto the Track
Manager or directly into a Composition. You can also add a picture track using
the main menu navigating through “Track -> Add Picture Track..”.

Depending on the amount of image files in the selected directory, both
browsing and opening an image file sequence may take some time.

easyDCP Creator will take the selected picture file as the first frame for the
Picture Track and will also pick all subsequent images (of this format) in the
same folder which belong to the sequence. If the fifth picture file (e.g.
big_buck_bunny_00004.j2¢) of this image sequence is selected, the imported
Picture Track will start at this fifth picture and the first four pictures will be
ignored.

According to the DCl standards, the duration of a DCP has to be at least one
second. The amount of frames varies, depending on the current project’s frame
rate (e.g. 24 frames for 24 fps). If you open an image file sequence with
duration less than one second, an error will be shown for the reel and before
generation.

Furthermore, each picture in a sequence is required to have the same
resolution.

5.1.2 Add Stereoscopic Picture Track

To add a Stereoscopic Picture Track select “Track -> Add Stereoscopic
Picture Track..” in the main menu. The following dialog will open:

. Add Stereoscopic Picture Track *

Source File(s)

First File of Image Sequence (Right Eye):
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To add a stereoscopic picture Track to the Track Manager, just choose separate
file sequences for each eye, i.e. one file sequence for the left eye and one file
sequence for the right eye. Both file sequences are required to have the same
number of files, resolution and format. Usually, these file sequences should be
in different folders. If you want to load a stereoscopic MXF file, load it in the
left-eye-field and leave the one for the right eye empty.

If a Picture Track is stereoscopic is signaled by the 3D indicator of the Picture
Track.

5.1.3 Numbering of input image file sequences

To represent an image sequence, the image files shall be numbered with or
without leading zeroes (see Examples 1 and 2). Additionally, the prefix may also
contain digits (see Example 3).

Example 1 (with leading zeroes)

Img 0000001.DPX
Img 0000002 .DPX
Img 0000003.DPX
Img 0000004 .DPX

Example 2 (without leading zeroes)

Pic_998.J2C
Pic_999.J2C
Pic_1000.J2C
Pic_1001.J2C

Example 3 (with numbers in filename)

Pic2001 998.TIF
Pic2001 999.TIF
Pic2001_1000.TIF
Pic2001 1001.TIF
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5.1.4 Add Still Picture Track

A Still Picture Track is a convenient way to show small local advertisements.

@ yMovie FTR_F_EN-

INT_31_2K_AFLM_20220822_171_SMPTE_OV [DCP/!
File Edit Track Cc ition Package Pres
@ MyMo Add Picture Track...
Add 5 Picture Track...
Tracks
Add 5till Picture Track...
E T \dd S Still Picture Track |
Add Sound T
Add Subtitle

Add Aux Da y Atmos / DTS:X Track...

Add Multi Source Track...

Check All Source Files (Picture Tracks only).. F7

To add a Still Picture Track or Stereoscopic Still Picture Track to the Track
Manager, select either “Track -> Add Still Picture Track..” or
“Track -> Add Stereoscopic Still Picture Track..” in the main
menu.

The following dialog will appear. For the stereoscopic case a similar dialog will
appear with an additional input for the right eye still image.

@ ~dd still Picture Track X
Source File(s)

Picture File:  equenzen/Formatesammlung/Einzelbildsequenz eft_right/L0.bmp ...

Duration

Display Time: 1

Cancel 0K

Now you can choose a picture file and a display time in seconds that defines
how long the picture will be displayed on screen.

After pressing ,OK", the still picture will be added to the Track Manager. The

frame count of the still picture will be calculated automatically, depending on
the current project’s frame rate.
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5.1.5 Supported Image File Resolutions

A DCP typically has one of three aspect ratios:

Aspect Ratio 2K 4K

Full Container 2048 x 1080 4096 x 2160

Scope (2.39:1) 2048 x 858 4096 x 1716
Flat (1:85:1) 1998 x 1080 3996 x 2160

In theory, other resolutions are valid as well. The DCl specifications state that at
least one side must fill out the full container. However, for best interoperability
you are recommended to stick to one of the above aspect ratios.

If your input images do not already have any of the above resolutions, they can
be scaled and/or black bars can be added at the sides. The next chapter
describes the various options in more detail.

5.1.6 2K/4K Container Resolution

The Container Resolution property defines the full container resolution of the
Picture Track that is used as target for Letterboxing & Scaling. To create a 2K
DCP the Container Resolution must be set to 2K for all Picture Tracks used in
the DCP.

The Container Resolution of all Picture Tracks in a Composition must be set
to the same Container Resolution. A DCP can be composed of multiple
Compositions with different Container Resolutions (2K/4K).

When adding a Picture Track, easyDCP Creator will automatically preselect 2K
for all sources with a resolution smaller or equal 2K. For sources with greater
resolutions 4K will be preselected.
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The Container Resolution can be changed via the property menu. Changing the
Container Resolution may also be required to create a 2K DCP from a 4K
source or vice versa.

[# MyMovie FTR_F EN-XC{_INT_51_2K_AFLM
Tracks

[} Picture 43} Sound  (}Subtitles

H big_buck_bunny_00001
¥ 2}

v

5.1.7 Letterboxing & Scaling

Pillarboxing is the process of adding black bars (“pillars”) at the left and right
sides.

Letterboxing is the process of adding black bars on the top and bottom.

By default, all input images will be pillar- or letterboxed to Flat, Scope or Full
container, whichever is the closest match.

Example: if the source material were in HD (1920x1080), narrow black bars
(each 39 pixels wide) would then be added to the left and right so that the
DCP’s aspect ratio becomes “Flat” (1998x1080).

This ensures that all sequences within a multi-Reel Composition will have
identical resolutions and that the Composition has a DCl-compliant aspect ratio
that will playback as expected on a D-cinema server. Many servers only have
presets for “Flat”, “Scope” and “Full”. Selecting the correct preset is often
required in order for the timed text to be properly positioned and for the

curtains to be aligned exactly at the image’s left and right edges.
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Of course you may manually override the automatic mode and pick any other
strategy.

@ - TEST_FTR_F_EN-XX_INT_51_2K_NULL_20201208_NUL_SMPTE_OV [DCP 2k/24FPS/SM

File Edit Track Composition Package Previ ew Help
[# TEST_FTR_F_EN-}X_INT_51_2K_NULL_20201209_NUL_SMPTE_OV

Tracks Timeline

L Picture o} Sound (3 Subtitles TEST FTR_F_EN-XX

00:00:00:00
L}
v Off

Silence for: big_buck_bunny_000
Flat
Silence for: big_buck_bunny_000

0osuUB

2K (1.90:1)

If scaling is set to Scaling Off, no scaling will be applied.

Scale To Fit will scale the image so that it completely fits the target resolution,
but without any cropping. Black bars will probably have to be added to reach
the target resolution. The aspect ratio of the input image will not be changed.

Scale To Fill will scale the image until the target resolution is reached in both
width and height. No black bars will be added. In case the scaled width or
height then stretches beyond the target resolution, parts of the input image
will then have to get cropped. The aspect ratio of the input image will not be
changed.

Regardless which combination of boxing or scaling options is selected, the
input image sequences’ native aspect ratio will always be maintained so that
images will never get disproportionally distorted.

5.1.8 Color Processing

In a DCP, all images are required to be in the “XYZ (DCI)" color space with a
gamma of 2.6. Since the input material imported into easyDCP Creator is
typically not in this color space, but often in RGB, all images have to be color
processed. In case the imported image sequences are in the right color space,
e.g. when you are importing JPEG2000 codestream files (*.j2¢) from an existing
DCP, color processing can be bypassed by setting the source color space to
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“XYZ (DCI)". This will also have a positive impact on the DCP render
performance.

In easyDCP Creator, color processing can be done via selection of
e a color transformation XML file preset (*.xml),
e auser generated 3D lookup table file (*.3dl) or
e source and destination color spaces XML file presets (*.xml),

If color processing is activated, you see a small icon on the track. If color
transformation is bypassed, the color processing icon is absent.

In easyDCP Creator the color processing is specified individually for each picture
Track. To do so, right click on a picture Track and select “Color Processing” or
simply click the picture Track’s color space button:

. * TEST_FTR_F_EMN-XX_INT_51_2K_MNULL_20201209_NUL_SMPTE_OV [DCP 2k/24FP5/5N

File Edit Trac Co Yack Help
[ TEST_FTR_F_EN-X 51_2K_NULL . 09_NUL_SMPTE_OV

Tracks Timeline

[ Picture 9} Sound (2 Subtitles TEST_FTR_F_EN-XX]

00:00:00:00

Color Transform Presets

In versions prior to 3.3.2, color transforms were of the form “source space ->
target space”. Each transform is represented by a file in the color transform
repository. They use a proprietary XML format. The files can be edited and new
ones can be added. These types of color transforms are still available for
backwards compatibility. In the screenshot above, select the “Color Transforms
/ 3D LUTs"” group box. The repository can be opened by clicking the folder icon.
New files or 3D LUTSs (*.3dl) can be added with the plus icon.
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5.1.8.11TU 709 to XYZ Color Transformation (default)

Using this chain assures a DCI compliant processing of the input images.
easyDCP Creator takes care about the color transformation and JPEG 2000
encoding. EasyDCP Creator expects RGB images with a SRGB/709 color gamut.
Use this chain if you don’t want to take care about color spaces and format
conversions.

Note: The color transformation from linear RGB to linear XYZ uses the matrix
defined in SMPTE RP177 Annex B.3, as SRGB/709 has other primaries and white
points than the reference projector.

Input values:
REC/TU 709  De-Gamma RGB RGB -> XYZ XYZ Gamma  X'Y'Z
R'G'B’ (2.2) (2.6)

The ranges of values describing the white level and the black level of the ITU
709 standard are not utilized. This means that black is represented by a value
of 0 by each component. On the other hand white is represented by the
maximum value of the file format.

Example 1: TIFF files with 8 bits => Maximum value = 28— 1 = 255
Range [0..255]
Example 2: DPX files with 10 bits => Maximum value = 2°- 1 = 1023

Range [0..1023]

Normalization and Degamma:

Using the given input values easyDCP Creator normalizes the input values and
applies a de-gamma of 2.2

Color Transformation:

The ITU 709 color values will be converted to XYZ color space using the
primaries shown in the following table.

D65 —ITU

709/sRGB X y
R 0,6400 0,3300
G 0,3000 0,6000
B 0,1500 0,0600
w 0,3127 0,3290
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Gamma and De-normalization:

In this step a fixed gamma of 2.6 will be applied on the normalized XYZ values.
Afterwards a de-normalization step will map the bit-range to 12 bit output
values which is necessary for the correct JPEG 2000 encoding.

What input data characteristics should the R'G’'B’ pixels have?

easyDCP Creator uses full input range, means e.g. for 10 Bit 0..1023 code
values (black is 0, white is 1023).

R’G'B’ means a gamma of 2.2 is applied to the linear RGB values.

The color gamut of the RGB values should be sRGB/ITU 709 with D65 white
point.

. * TEST_FTR_F_EMN-XX_INT_51_2K_MULL_20201203_NUL_SMPTE_OV [DCP 2k/24FP5/SMPTE] - easyDCP C
File Edit Track Composition Package Preview View Help

[# TEST_FTR_F_EN-XX_INT_5 NULL_20 19 NUL_SMPTE_OV DCP (SMPTE)
Tracks Timeline

[} Picture 4} Sound (3 Subtitles TEST_FTR_F_EN-XO(INT 5

00:00:00:00

‘ Color Transforms / 3D LUTs

Color Transform / 3D LUT:

¢

None

) full range, gamma 2.
Il range, gamma 2.6, P
b'Cr'| no chromatic adaption

5.1.8.2 3D Lookup Table (3D LUT)

3d lookup tables can combine complex image processing steps, hence speeding
up image processing.
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To choose a 3d lookup table for a specific Picture Track, right-click on the
Picture Track and choose “Color Processing -> 3D Lookup Table..”:

To ensure that lookup tables have the correct file format, check the example
3d lookup tables, delivered with this software in the folder ,Example Lookup
Tables”.

5.1.8.2.1 Supported 3D Lookup Table File Formats

Unfortunately there are no established standards for lookup tables. easyDCP
Creator will read the most popular ,,3dl” files. The supported file formats are:

ASCII File Format

Bit Depth: 1..16
Supporting Points: 2..128

XML file format as well as floating point values are not yet supported.

5.1.8.3 Bypass Color Processing

Bypassed color processing is used if the source image files already are in the
right color gamut.

To bypass color processing for a specific Picture Track, right-click on the Picture
Track and choose “Color Processing -> XYz":

Color Transformation has to be bypassed if you want use direct copying of
the source image files into the final DCP without re-encoding. For proper
metadata you sometimes need to select and identity color transformation by
selecting the same source and destination color space.

5.1.9 Export Frames to JPEG 2000 Codestream (J2C) Files

To export the source image files of a specific Picture Track, right-click on the
Picture Track and choose “"Export Frames..”:
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@ - TEST_FTR_F_EN-XX_INT_51_2K_NULL_20201209_NUL_SN

(& TEST_FTR_F_EN-XX_INT_51_2K_NULL_20
Tracks
£} Picture 4} Sound () Subtitles

Encrypt

After pressing ,Export Frames..”, the easyDCP Standalone JPEG 2000
Transcoder comes up:

@ <as/DCP IPEG 2000 Standalone Transcoder 4.0.0 - O X

Options  Help
Paths
First Input File Name: stSequenzen/Formatesammlung/Einzelbildsequenzen/TIFF/R

Output Folder Name:  D:i/delete

Full

Scale to Fit

r Transformation:

Standard RGB (sRGE) T XYZ(DD)

Bit Depth:
Use JPEG 2000 Visual Weightings (CPU only)

Bit Rate:

[0 Enable Higher Bit Rates

Ready for processing.

Several settings are obtained from the current easyDCP Creator project (e.g.,
resolution, stereoscopic or not, InterOp or SMPTE, framerate, color processing,
pillar-/letterboxing, scaling, bitrate).

Choose an output folder where the processed image files will be stored. Press
Start to start the processing.
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5.2  Sound Tracks
The audio format of a DCP is specified to be:
e uncompressed
e 24 bits per sample
e Sampling rate of 48 KHz (or 96 KHz)

e Upto 16 Channels

easyDCP Creator will automatically convert any supported input (see 5.2.6
Supported Sound File Formats) to match the specification.

5.2.1 Add Sound Track

To add sound material to the Track Manager, click the “Sound”-button on the
top of the Track Manager or use the main menu “Track -> Add Sound

Track...”.

The following dialog will appear where you can load one or more single- or
Multi-channel files that will be combined into a sound Track.

L(1)
R(2)

c@

LFE(4) =

Ls(5)

Rs(6) -
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5.2.1.1 Layout

The Add Sound Track dialog offers two modes to set the channel layout of the
Sound Track.

Preset — In this mode a layout can be chosen from a predefined set of
configurations. The values in the custom layout section will be updated
according to the selected preset.

Custom Layout - This mode gives more control over the layout configuration.
Depending on the variant set in the project configuration it allows to set the
Audio Channel Format and channel count or a Multi Channel Audio Framework
labeling.

InterOp and SMPTE Audio Channel Format Wild Track Format do not define
a channel layout. In this case easyDCP Creator will fall back to and display
the default layout defined in ISDCF Document 4 — Audio Channel
Assignments.

5.2.1.2 Config

The Config section can be used to set additional parameters of the Sound Track
that are not part of the channel layout.

Sampling Rate - The target audio sampling rate of the Sound Track in the
DCP. Supported options are 48 kHz and 96 kHz.

Sources with different sampling rate will be converted to the selected target
sample rate.

Duration - If any source is present, this will display the duration of the Sound
Track and edit will not be possible. In case no source is present the duration of
the then silent Sound Track can be set.

5.2.1.3 Source Files

In the Source Files section one or multiple source files can be added either via
drag & drop or a file browse dialog. If a file contains multiple channels, all
sources for the following channels will be auto filled. Channels with existing
sources will be skipped.

The first column shows the channel layout of the Sound Track as configured
in the Layout section. The drop down on the right-hand side shows the
detected layout of the source channels and the channel number.
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The mapping of the source channels to the layout can be changed by
rearranging the channels via drag & drop or by selecting the source channel via
the drop-down source channel selector. If easyDCP Creator detects any channel
labeling in the source, the channels will be labeled accordingly in the source
channel selector.

For each channel with a source file the source metadata will be displayed. This
includes sample rate, sampling depth and duration.

Channels with no source set will be filled with silence. A silence Sound Track
can be created by leaving all channels empty and setting the desired duration
in the Config section.

5.2.2 Multi-Channel Audio Labeling Framework

With Multi Channel Audio Labeling Framework (MCA) every used (, non-silent)
channel is labeled with a specific Audio Channel Label that represents the type
of the channel. Multiple channels can be grouped together by a Soundfield
Group like 5.1.

Sound Tracks of SMPTE 429 DCPs may be labeled with the MCA Framework.
This can be done either by selecting a MCA preset or by using the Custom
Layout mode. With SMPTE 429 DCP the use of MCA in easyDCP Creator is

currently limited to one Soundfield Group and its associated Audio Channel
Labels.

Sound Tracks of RDD 52 DCPs shall be labeled with the MCA Framework. MCA
is required and any preset will use MCA. Furthermore MCA cannot be disabled
in the Custom Layout mode.

5.2.2.1 Optional Channels (RDD 52)

With RDD 52 the following optional special use-case channels exists:

Channel Use Case
No.
7 Hearing Impaired
8 Visually Impaired-Narrative
13 Motion Data
15 Sign Language Video Stream
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These channels do not belong to the Soundfield Group and have to be explicitly
labeled. This can be done by setting the layout mode to Custom Layout and

switching the required Audio Channel Label on or off via the Option Channels
menu.

5.2.3 Add Sound Track for Dolby Atmos

In case of RDD 52 the Immersive Audio (Atmos) preset should be used.

If a reel contains a Dolby Atmos track, the Main Sound Track has to provide a
sync signal that is automatically generated on channel 14. Select one of the
Dolby Atmos presets from the “Add Sound Track” dialog and mark unused
channels, plus the actual sync channel 14, as silent by leaving their field empty:

® Custom Layout

Audio Channel Format: Channels:

Soundfield Group: 2.1 Optional Channels ~

7: Hearing Impaired

Config 8 ly Impaired-Narrative

13: Motion Data
Sa ing Rate: ) . .
Sl = = v 15:Sign Language Video Stream
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~ Duration:

LFE(4)

Left Surround 1s(5)

Right Surround Rs (6)

Syne Signal

oK Cancel

A 14 channel Sound Track will be added to the Track Manager. The
synchronization signal will automatically be generated on channel 14.
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5.2.4 Add Sign Language Track

In case of RDD 52 the Sign Language Video Stream Audio Channel Label has
to be explicitly set (see 5.2.2.1 Optional Channels (RDD 52)).

Brazilian Sing Language is wrapped in channel 15 of the corresponding sound
track. To set it up in easyDCP Creator select the 16 Channels WTF preset from
the “Add Sound Track” dialog and leave unused channels empty to mark them
as silent, but put your sign language video In channel 15:

Ly -
RE) ~
@)

LFE(@4) =

Is(5) =

Rs(6) ~

learing Impaired

Visually Impaired-Narrative

Left Center

Sign Language Video Stream

Supported input formats for sign language video are WAV and H264
encoded videos. The resolution has to be 480x640 with 24 fps.

For details check ISDCF Document 13.
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5.2.5 Edit Sound Track

easyDCP Creator allows to edit the configuration of existing Sound Tracks
added by the user or loaded from an existing DCP. Editing can be accessed by
"Edit Audio Sources” from the Sound Track context menu.

Delete Del
Duplicate Cerl+D

Edit Audio Sources  Ctrl+E

Show in Explorer

Encrypt

This will open the Add Sountrack Dialog. OK to apply or Cancel to revert any
changes.

The layout mode will be automatically set to Custom Layout if the Sound
Track was loaded from a DCP or the Variant of the DCP was changed via the
Project Configuration.

5.2.6 Supported Sound File Formats

easyDCP Creator supports the following audio codecs and file formats:

Uncompressed PCM *.wav, *.wave, *.mov, *.mp4, *.mxf

Advanced Audio Coding  *.aac, *.mov, *.mp4

MPEG-1/2 Audio Layer Il *.mp3, *.mov, *.mp4

Audio Interchange * aiff, *.aif

Broadcast Wave Format * bwf
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5.3  Subtitle Tracks
5.3.1 Add Subtitle Track
To add timed text to the Track Manager, click the quick button “Subtitle” on
the top of the Track list. The word “subtitle” is used here as a synonym for
timed text.
Subtitle is only one example of timed text. The other example is Captions.
Both subtitles and captions can be either Open or Close. This yields four
combinations:
e Open Subtitles
e Closed Subtitles
o Open Captions
e Closed Captions
Open subtitles or captions will be displayed on the main screen and be visible
to everyone in the audience, while Closed subtitles or captions are meant to be
displayed on secondary screens available on demand.
Subtitles usually translate only the spoken words, while Captions are meant to
aid deaf and hearing-impaired audiences and often also describe background

sounds (“classical music is playing in the radio”).

While a DCP with InterOp conformity only supports Open Subtitles, a SMPTE
DCP allows all four combinations.

5.3.2 Supported Subtitle File Formats

Currently easyDCP Creator does not support converting between timed text
formats.

When creating a DCP with InterOp conformity, the source is required to be in
the Texas Instruments CineCanvas format, which is based on XML.

When creating a DCP with SMPTE conformity, the source is required to be in
the SMPTE 428-7 D-Cinema Distribution Master — Subtitle format, which is also
based on XML. Both formats are explained in more detail in the next two
chapters.

5.3.2.1 Texas Instruments CineCanvas (InterOp)
Interop compliant subtitles are based on the “Subtitle Specification for DLP

Cinema™ Projection Technology” published by Texas Instruments. The default
file extension is ,,.xml"”. The XML root node is “DCSubtitle”.
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An Interop compliant subtitle XML file should look like the following example:

<?xml version="1.0" encoding="UTF-8" ?>
<DCSubtitle Version="1.0">
<SubtitleID>97£d79ed-b2ff-468c-bl1f-1a3792fc90dc</SubtitleID>
<MovieTitle>Example Movie Title</MovieTitle>
<ReelNumber>1</ReelNumber>
<Language>English</Language>
<!-- For testing this subtitle example, you need to copy a font file (e.g.
"arial.ttf") right next to this XML file. -->
<LoadFont Id="arial" URI="arial.ttf" />
<Font Id="arial" Color="FFFFFFFF" Effect="shadow" EffectColor="FF000000"
Size="42">
<Subtitle SpotNumber="1" TimeIn="00:00:02:000" TimeOut="00:00:07:000"
FadeUpTime="2" FadeDownTime="2">
<Text HAlign="center" VAlign="bottom" VPosition="10.00">Example Subtitle Text
One with LoadFont.</Text>
</Subtitle>
<Subtitle SpotNumber="2" TimeIn="00:00:08:000" TimeOut="00:00:12:000"
FadeUpTime="2" FadeDownTime="2">
<Text HAlign="center" VAlign="bottom" VPosition="10.00">Example Subtitle Text
Two with Loadfont.</Text>
</Subtitle>
</Font>
</DCSubtitle>

<DCSubtitle Version="1.0">
The DCSubtitle tag indicates the root of the XML subtitle file. It includes the
attribute version. The version is an optional attribute. If not specified, the
projector will assume the latest version.
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<SubtitleID>

<MovieTitle>

<ReelNumber>

<Language>

<LoadFont>

The value of the SubtitleID tag is a hexadecimal Universally Unique Identifier
(UUID). To generate a UUID there are several UUID generators available.
easyDCP Creator will generate a new random UUID during packaging.

The MovieTitle tag contains the name the title of the movie in which the
subtitle shall be embedded.

The value of the ReelNumber tag indicates the Reel that subtitle was generated
for.

The value of the Language tag indicates the subtitle language.

This field is optional. If present, easyDCP Creator will try to find the font file
and packs it into the DCP. The font file must not be larger than 640kB.

<Subtitle SpotNumber="1" TimeIn="00:00:01:000" TimeOut="00:00:05:000"
FadeUpTime="20" FadeDownTime="20">

SpotNumber

TimeIn

TimeOut

FadeUpTime

FadeDownTime

The Subtitle tag indicates the beginning of a specific subtitle. The tag contains
the following attributes and attribute-values:

The SpotNumber identifies a particular subtitle location. The number is user
definable.

The value of the Timeln attribute indicates the first appearance of the subtitle.
The formatting is HH:MM:SS:TTT (H=hours, M=minutes, S=seconds, T=ticks).
The ticks can take the values 0-249, where one tick equals 4msec.

The value of the TimeOut attribute indicates the complete disappearance of the
subtitle. The formatting is HH:MM:SS:TTT (H=hours, M=minutes, S=seconds,
T=ticks). The ticks can take the values 0-249, where one tick equals 4msec.

The value of the FadeUpTime attribute defines the duration of the subtitle fade
in. The formatting is TTT (T=ticks). The ticks can take the values 0-249, where
one tick equals 4msec.

The value of the FadeDownTime attribute defines the duration of the subtitle
fade out. The formatting is TTT (T=ticks). The ticks can take the values 0-249,
where one tick equals 4msec.
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<Text Direction="horizontal” HAlign="center" HPosition="0"” VAlign="bottom"
VPosition="10.00">

Direction

HAlign

HPosition

VAlign

VPosition

The value of the text tag is the actual subtitle text which appears on screen.
The tag may contain the following attributes and attribute-values:

The value of this attribute indicates the direction of the rendered subtitle text.
Valid values are horizontal and vertical. Default direction is horizontal.

The value of this attribute indicates the horizontal alignment. Valid values are
left, right and center. Default horizontal alignment is center.

The value of the HPosition attribute indicates the horizontal position of the
subtitle relative to the alignment value. The HPosition value is expressed as a
percentage of the picture width from the edge or center according to the
HAlign attribute. For example, HPosition="9.5" in conjunction with
HAlign="left” implies that the text starts at a position 9.5% of the picture
width from the left edge of the image. To center the text, choose
HAlign="center” and HPosition="0". Default horizontal position is 0.

The value of this attribute indicates the vertical alignment. Valid values are top,
bottom and center. Default vertical alignment is center.

The value of the VPosition attribute indicates the vertical position of the subtitle
relative to the alignment value. The VPosition value is expressed as a
percentage of the picture height from the edge or center according to the
VAlign attribute. For example, VPosition="10" in conjunction with
VAlign="bottom"” implies that the text starts at a vertical position 10% of the
picture height from the lower edge of the image. The vertical position specified
is the baseline on which the text is drawn. Default vertical position is O.
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5.3.2.2 SMPTE Subtitle

SMPTE compliant subtitles are based on the specification “428-7 D-Cinema
Distribution Master — Subtitle” published by the SMPTE for XML files or “429-5
D-Cinema Packaging — Timed Text Track” for mxf files. The xml is the raw
format before packaging, while the mxf is the distribution format for
unencrypted and encrypted subtitles.

A SMPTE compliant subtitle XML file should look like the following example:

<?xml version="1.0" encoding="UTF-8" 2>
<SubtitleReel xmlns="http://www.smpte-ra.org/schemas/428-7/2010/DCST">
<Id>urn:uuid:94d3a710-b4b5-4b28-a020-eafb2£f24c75d</Id>
<ContentTitleText>Example Content Title</ContentTitleText>
<AnnotationText>Example Annotation Text</AnnotationText>
<IssueDate>2012-05-02T12:59:04+02:00</IssueDate>
<ReelNumber>1</ReelNumber>
<Language>en</Language>
<EditRate>24 1</EditRate>
<TimeCodeRate>24</TimeCodeRate>
<StartTime>00:00:00:00</StartTime>
<!-- For testing this subtitle example, you need to rename a font file (e.qg.
"arial.ttf") to "5b0283b9-3c28-42a6-86ad-c22acb431665" and copy it right next to
this XML file. -->
<LoadFont ID="Arial">urn:uuid:5b0283b9-3c28-42a6-86ad-c22acb431665</LoadFont>
<SubtitleList>
<Font ID="Arial" Color="FFFFFFFF" Weight="normal" Size="40">
<Subtitle SpotNumber="1" TimeIn="00:00:02:00" TimeOut="00:00:07:00">
<Text Valign="top" Vposition="10.00">Example Subtitle Text One with
LoadFont.</Text>
</Subtitle>
<Subtitle SpotNumber="2" TimeIn="00:00:08:00" TimeOut="00:00:12:00">
<Text Valign="top" Vposition="30.00">Example Subtitle Text Two with
LoadFont.</Text>
</Subtitle>
</Font>
</SubtitleList>
</SubtitleReel>

<Id>
The value of the tag “Id” is a hexadecimal Universally Unique Identifier (UUID).
To generate a UUID there are several UUID generators available. easyDCP
Creator will not generate a new random UUID during packaging.

<ReelNumber>
The ReelNumber tag denotes the ordered placement of this file in a set of
DCDM Subtitle files. The value shall only be used for informative purposes and
shall not influence the reproduction of the subtitle instances. The value is a
positive integer in the range 1 .. n, where n is the total number of Reels in a
Composition.

<LoadFont>

The LoadFont tag is used to declare an OpenType [ISO/IEC 14496, Part 18] font
resource for use within the DCDM Subtitle file. The font is identified by a
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urn:uuid in the tag’s body. easyDCP Creator expects the entire external font
filename to match the value of the urn:uuid (without any file extensions like
L 1tf or . otf”). The font file must be located in the same folder as the subtitle

XML file. At least one LoadFont element shall be present.

5.4 Add Auxiliary Data (Dolby Atmos) Track

To add a Dolby Atmos MXF file to the Track Manager, hit “Add Aux Data /
Dolby Atmos Track”:

e Edit Track

[& TESTF

Tracks

B Pictu

) Sound Track

After choosing the Auxiliary Data MXF file, it will appear as a purple sound
track in the Track Manager.

Tracks Package Content
; 3 ]
£3 Picture 4} Sound O3 Subtitles TEST_FTR_F_EN-XX_INT_51_2K_NULL 209_NUL_SMPTE_O
big_buck_bunny_00000 Reel 1 New Reel

- H big_buck_bunny_|

‘))) lence for: big_buck_bunny_00000

Q lence for: big_buck_bunny

osuB -

NT_51-ATMO S il <f> aTMOS_ 09_ztmos_01.mxf

A Dolby Atmos track must be paired with a 14 channel Main Sound Track,
containing a synchronization signal on channel 14. If a Dolby Atmos track is
present in a reel, the synchronization signal will automatically be generated into
channel 14 of the reel’'s Main Sound Track.

5.5 Add multi source track

If you need to combine multiple separate files into one mxf you can use this
option. The order of files determines the order they are shown, from top to
down. Adding a file sequence the whole sequence counts not just the selected

frame.
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. * TEST_FTR_F_EM-XX_INT_51_2K_NULL_2020120%_NUL_SMPTE_OV [DCP 2k
File Edit Track Composition Package i

Add Picture Trac

(& TESTF

Add 5till Picture Track...
Tracks

B Pictu

b Add Aux Data / Dolby Atmos / DTS:X Track...

Add Sound Track...
Add Subtitle T

Add Multi Source Track...

Check A Add Multi Source Track | g cpe only)...

With the “+"” und “-" button you can add and remove files. With “Arrow up”
and “Arrow down” buttons you can change the order.

& ~dd Multi Source Track *

oK Cancel

The formats and properties of the files have to match to be used together,
e.g. same resolution and same file format.

5.6 Check Source Files

To check only the source files of a single Track, right-click on a Track and
choose “Check Source Files..™“:
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Tracks

£} Picture 4} Sound () Subtitles

Check Source Files...

Export Fr:

Encrypt

Corrupt H
Equal

Suspicious Big Fi s JPEG 2000 profile marker

Detected Issues
Info Warning Error Save As Clear

Timestamp

102 file(s) to check. Press Start to check.

Start Close

By default all checks are included (recommended). Checking for headers may
slow down the checking progress, so if this will take too long you can disable
this option.

Error Messages are displayed. If errors occurs during check, for example is a file

is zero in size, read the warnings carefully and try to fix the problem. Then try
again until no problems occur anymore.
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5.6.1 Check All Source Files

To check all source files, choose the menu entry “Track -> Check All
Source Files..™ orsimply press F7 (see screenshot below).

. * TEST_FTR_F_EM-XOCINT_51_2K_MULL_20201209_MUL_SMPTE_OV [DCP 2k/24|
File Edit Track Comp

(@ TESTF Add Picture
Trach Add Still Picture Track...
racks
Add Sound Track...

] Picw

Add Subtitle Track

b Add Aux Data / Dalby A

Add Multi Source Track...

Check All Source Files (Picture Tracks only)... F7

Check All Source Files (Picture Tracks «

Silence for: big_bud
—

5.7 Remove / Delete Tracks

To remove an item from the Track Manager, mark it and press the “Delete”
key. Alternatively right-click the Track to open its context menu and select
“Delete”. The Track will be removed from the list. This action will not physically
delete any source files.

Tracks

{5} Picture 4} Sound

")) Silence for: |
Silence for: |
Q osus

NT_51-ATMC

<>

Encrypt

If the Track has already been added to one or more Reels, these references will
be removed as well.
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6  Composition Manager

The "Package Content” window is where you compose your package by
creating Composition Playlists (CPL). When starting off with a new project, you
can already see the first CPL with an empty Reel.

A CPL is comprised of one or more Reels that will be seamlessly played back-to-
back, i.e. when played there are no gaps in-between Reels. There is no
preference to a multi-Reel CPL over a single-Reel CPL. Use whatever option is
more convenient to you.

6.1 Add Composition

If you want to place more than one composition in your package, you can
create additional compositions. To achieve this, just click the “+" (“Add
Composition”) button on the right side of the composition.

Package Content

MNew Reel

Add Compaosition

easyDCP Creator will create a new composition in the Reel Window.

6.2  Add Tracks to Composition

To add a Track to a Reel, simply drag & drop the Track from the Track manager
into the desired Reel. All Tracks within a Reel will be played in parallel to each
other.

Each Reel needs to contain at least a picture Track, but typically it will also

contain an audio Track. A Reel may have zero, one or more timed text Tracks,
provided they all use distinct display type (Open/Closed Subtitles/Caption). For
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instance, a single Reel may contain an Open Subtitle Track and a Closed
Caption Track. It may not contain more than one Open Subtitle Track.

The first Track that is added to an empty Reel needs to be a Picture Track. If you
try to place a Sound or timed text Track into an empty Reel, the action will be
ignored.

When adding a Track to a Reel that already contains a Track of the same type,
the existing Track will be replaced with the new one.

After placing a media Track in an empty Reel, a new empty Reel placeholder is

Package Content

TEST_FTR_F_EN-XX_INT_51_2K_NULL_20201209_|

Reel 1 leel 2 New Reel

automatically appended at the end of the CPL. As long as there is no content in
the Reel, it is called “New Reel” and it will not end up in the rendered DCP.
You can place additional media Tracks in the new Reel. All Reels will be
combined into a Composition in the package later.
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6.3  Change Offset (EntryPoint) and Duration

In some cases you may want to crop the beginning and/or end of a Track.
Double-click a Track within a Reel to change its offset or duration:

Package Content
TEST_FTR_F_EN-}3{_INT_51_2K_NULL_20201209_NUL_SMPTE_OV

Reel 1

Duraticon in Frames

Offset in Frames

©

Skipping frames at the beginning can be done by changing the offset to a
value (in frames) larger than zero. If you want to hide the first two seconds of a
Track with an edit rate of 24 fps, set the offset to 48.

If you want to truncate the Track, decrease the duration. Example:

Your Track has an intrinsic duration of 100 frames. You want to hide the first
10 and last 20 frames. Then you would set the offset to 10 and the duration to
70 (100-10-20=70).

The In- and Out-markers as defined by the offset and duration are displayed in
the Preview Window's timeline when a single Track within a Reel is selected:

There are various further use cases where the offset and duration properties
might be convenient.

Use case: Cut Scene

You can even use this option to cut a scene from a Track. To do that add the
same Track to two consecutive Reels. Set up the duration of the Track in the
first Reel, so that it stops just before the scene that you want to cut out starts.
In the second Reel, set the offset of the Track so that it starts just after the
scene is over.
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Use case: Insert scene

Also, you can add an insert. Assume you have a Track that contains the entire
movie, but you want to add a pause in the middle and show a message, you
could create a JPEG with the message and create a new still-picture Track from
that JPEG. Put the main movie Track in the first Reel, the pause Track in the
second Reel and again, the main movie track in the third Reel. Assuming your
main audio and picture Tracks are each 90 minutes long, they have an intrinsic
duration of 129600 frames given an edit rate of 24 fps (90x60x24=129600). In
the first Reel, decrease the duration to 64800 (129600/2=64800) and in third
Reel, set the offsets to 64800.

Use case: shift audio and video relative to each other

Assume your picture Track has a film leader showing a count-down with a
duration of a 100 frames, but your audio Track’s leader only has a duration of
80 frames. In this case, you can set the picture Track’s offset to 100 and your
audio Track’s offset to 80. Now you have shifted the two Tracks relative to
each other and they will be in sync.

6.4  Move Content within Compositions and to other Compositions

You can easily move Reels within a Composition using drag & drop. Just click
on a Reel with the left mouse button and hold the button down. Then move
with the mouse to the new position for the Reel and release the mouse button.
The positions where you can place the Reel are getting highlighted with a
green bar when moving over with the mouse.

Package Content

TEST

Reel 1 Reel 2

H MM_2K_XYZ_000.tif H MM_2K_XYZ_000.tif
3 3 |

MM_2K_XYZ_000.tif
e Sound Track for: MM_2t B;

ce Sound Track fo

Silen
o,

6.5 Delete Reel
Choose the Reel you want to remove from the Composition and click the trash

can symbol button in the Reel’s tool bar. You can also select a Reel and hit the
shortcut “Del”. The selected Reel is indicated by a blue border:
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Package Content

TEST_C X 0119 I0P_OV

Reel 1 Reel 2 New Reel

H Picture Track H Picture Track
» @

Silence for: Picture Track Silence for: Picture Track
D) )

6.6 Editing Composition Properties

You can easily edit the properties of your Composition by double clicking it or

v View Help
NUL_SMPTE_OV DCP (SMPTE) 2K 24f1  Annotation Text  N-XOCINT_51_2K_NULL_20201209_NUL_SMPTE_OV
Pac Conte feature -

TEST_FTR_F_EN-XX_INT_

Reel 1 Issuer Fraunhofer IS

H big b Issuer Language

by clicking the Edit-icon on the right of the CPL.

6.6.1 Content Kind of a Composition

The content kind is informational only. It defines the kind of material referred
to by the Composition playlist. The content shall match one of the values listed
in the table below. This kind may be displayed to the operator in the cinema
server. Some servers sort their DCPs and playlists by content kind so that the
projectionist can easily find trailers, advertisements or feature films.

Kind Description

feature A theatrical feature.
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trailer Short (2 to 3 minutes) content promoting an upcoming
theatrical feature.

test Content used to test, calibrate or setup D-Cinema
exhibition equipment.

teaser Very short (typically less than 1 minute) content
promoting an upcoming theatrical feature.

rating Slate/still picture indicating the recommended age group
permitted to view the content to follow. This rating is
generally unique per country.

advertisement Content promoting a product or service other than an
upcoming feature.

short Non advertising/promotional content (3 to 15 minutes)
typically before a theatrical feature.

transitional Extremely short content (1 to 15 seconds) separating
unrelated Compositions.

psa Public service announcement.

policy Content defining the code of conduct for patrons.

To edit the content kind of a Composition, double click or click the “Edit
Composition Parameters” button and select a kind from the dropdown list.

Annotation Text

Issuer Language

L big t
E

nce for: big_buck_bunny 00 s

If you typically create DCPs of the same content kind, it is convenient to change

N-OCINT_51_2K NULL_2 09_NUL_SMPTE_OV

feature =

feature

trailer

test

teaser

rating
advertisement
T
transitional
psa

policy

the Default CPL Content Kind in the Options dialog.
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6.6.2 Content Title

The Content Title appears on the screen if a volume (e.g. USB-Drive, Hard disc
Drive) is connected to a digital cinema system before ingest. This annotation
text describes the whole DCP. In contrast to the Annotation Text of the
Composition (CPL Annotation Text) it describes the whole DCP.

Some Digital Cinema servers only show a limited number of characters on their
display screens. If the title of a composition is long, much of the information
may be cut off or not visible unless you scroll to a second page. This makes
locating a specific composition difficult if you have multiple titles. It's especially
confusing when you have multiple trailers as well as the feature with the same
name. You should follow the Digital Cinema Naming Convention at
http://www.digitalcinemanamingconvention.com/

6.6.3 Conformity: InterOp or SMPTE

You already selected the conformity of your DCP project in the “New Project
Settings” windows. In the Compose view you can optionally change this setting
via the main menu bar:

@ * TEST_FTR_F_EN-X_INT_51_2K_NULL_20201208_NUL_SMPTE_OV [DCP 2k/24FPS/!
File Edit Track Composition Package Preview

@ TEST FTRF EN-OCINT 51 2k [terOp

+ SMPTE
Tracks

E Picture ‘,3 Sound Packing List (PKL) Parameters...

Reel 1

Neither an InterOp nor SMPTE DCP will work in a so called “E-Cinema”
system.

If you do not have a tangible reason to switch to Interop conformity, we
recommend using SMPTE as conformity mode.

6.7 Delete Composition

Deleting a composition is as quite as easy as creating one. Just choose the
composition you want to remove from the DCP and hit the “Delete
Composition” button in the tool bar. A composition is selected if there is a tiny
blue frame around the composition. The following screen shot will show how a
selected composition looks like:
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http://www.digitalcinemanamingconvention.com/

TEST_FTR_F_EN-XX_INT_51_2K_NULL _NUL_SMPTE_OV

Reel 1 Reel 2 New Reel

Delete Composition

6.8 Composition Metadata

SMPTE DCPs support composition metadata which is used on some cinema
servers to display informations. CPL metadata can be edited by clicking the icon
in the composition manager and timeline.

e Content
TEST_FTR_F_EN-)CCINT_51_2K NULL 09_NUL_SMPTE_OV

Reel 1 New Reel
Edit CPL Metadata

After clicking the CPL metadata dialog appears. Metadata that can be derived
from the CPL will be filled in automatically. This affects e.g. edit rate and
intrinsic duration. Other data has to be entered manually and so can be
changed.

For certain features like Sign Language and Eclair color special extensions are
provided. It is also possible to add arbitrary new extensions as key value pairs.
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[ Add extension... e

Name

6.9 Preview package

Before starting package generation, it is possible to preview the entire project
in easyDCP Player. If you have installed easyDCP Player, just click on the “Play
Preview"” button in the upper right corner:

@ {¥; Generate Package...

Preview Project in easyDCP Player

The easyDCP Player can directly play back project files (*.dcpproj) containing
source files (e.g. DPX, WAV and Subtitle XML files), so it is possible to check
e.g. audio and video synchronization before generating the package.

7 Timeline

The Timeline was introduced in easyDCP Creator 3.5.0 with a first set of
features. You are able to preview your compositions and edit offsets and
durations. It can display picture, audio and timed text tracks. Audio tracks can
be shown both as combined waveform and with the channels split up.
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For DCP packages you can decide whether to use the Composition Manager or
the Timeline.

7.1 Timeline Controls

Time Code Edit

The time code on the left side of the timeline is clickable and allows to jump
directly to a specific time code. When it is selected it becomes blue and accepts
all keys from 0 to 9. Pressing enter will accept the input and jump to the
position in the timeline. It is also possible to start the editing via Ctrl + G after
clicking the timeline once.

Composition List
With the box on the upper left of the Timeline you can choose the composition

to be previewed in the Timeline. You can either select it using the combo box
or navigate through them with the arrows on the left.

TEARSOFSTEEL_FTR_S_EN-XX_51_2K_20130822_FHG_INT OV

Add Composition
Adds a new composition.

B Delete Composition
Deletes the composition that is currently selected for preview in the timeline.

@ Duplicate Composition

Clicking this button duplicates the current composition. In the popup you have
the possibility to reference the same track files as in the original or to duplicate
them.

Editing Composition Properties
See 6.6.
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fe Zoom
Use the slider to define the zoom level of the timeline. You can also zoom
using “CTRL + mouse wheel” while the mouse is over the timeline.

Zoom to fit
Shows the entire timeline in respect to the available space in the user interface.

Ripple edits for later items
Moves later items together with the currently selected clip.

Snap to clip borders

Helps to properly align different tracks in the timeline. If it is necessary to align
the duration of a video clip to the shorter duration of a given audio track, you
can simply reduce the length of the video track by clicking on the right edge of
the longer track file and moving the mouse to the left. Once the mouse pointer
gets close to the end of the shorter track, the size of the current track will snap
to the same length if snap to clip borders is activated. Once triggered, the snap
feature will also show a red vertical line at the boundary of the tracks it is
currently aligning.

J Center view on play head
Auto-aligns the timeline so that the play head is placed in the center.

Split sequence

Splits the sequence containing the playhead marker at the playhead marker
position into two reels and adjusts their offsets and duration to fit the original
length. Only selected clips that contain the playhead are split, so it's possible to
split just picture while keeping sound one clip.

i Render reels

In order to know where you're reels/segments will be split you can toggle
rendering of reels on. This will display the reel markers in ascending order on
top of the timeline with slightly alternating colors.
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L Render thumbnails
If active, thumbnails will be rendered for all video tracks in the timeline.

K Render waveforms

If active, a visual representation of each audio track will be displayed in the
timeline. Depending on the length of the audio tracks the rendering of the
waveform for the first time can take a while.

Navigation

Using arrow key left and right allows for frame wise stepping in the timeline.
With arrow up and down it is possible to jump to the next/previous clip in the
timeline.

Switching between time codes and frames

With a right-click into the empty space of the timeline a context menu opens.
There you can switch between the time code representation in the timeline and
frames.

Timeline

TEST_FTR_F_EN-XX_INT_51_4K_NULL_20200121_NUL_SMPTi ~ == @ » &

0

v Show frames instead of time code

R Picture Track

#) Sound Track

¢> Subtitle Track

7.2  Editing in the Timeline

The Timeline supports editing of offsets and durations of the Tracks,
rearranging sequences, drag & drop of tracks and files and functionality to split
sequences and insert tracks in between.

To edit the offset (entry point) of a track, just drag the left border of it. The
offset is directly updated in the Metadata Window. Dragging to the left
reduces the offset (if not already at 0), while dragging to the right will increase
the offset as long as possible.
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To change the duration of a track, drag the right border. Dragging to the right
will increase the duration while dragging to the left will shorten the track.

wav TOS_DVDSURR...

Both offset and duration are directly updated in the Metadata Window. The
maximum offset/duration depends on the tracks and the project type (DCP 1
second).

To add new tracks to the timeline it is possible to drag a track from the track
manager directly on the timeline. The track can be inserted in between two
existing sequences. To make an insert in an existing reel/segment for creating
supplemental DCPs drop at the position on select “Insert” in the context menu.
This will split the existing clip in the timeline at the mouse position and insert
the new clip resulting in a total of three clips instead of the previous one with
all offsets and durations being automatically adjusted.

Rearranging clips is also possible. Clips in the timeline can’t overlap and will
automatically be reset to their origin position when dragging started. But when
dragging a clip in between two others everything left will be moved left (when
coming from the left side) or right (when coming from the right side).

7.3  Appending/prepending black frames

For some purposes it's necessary to add black frames before or after a
reel/segment. To do so right-click the picture track file.

Timeline
TEST_FTR_F_EN-XX_INT_S51_4K_NULL_20200121_NUL_SMPTE > < fij W (&

0

[ Picture Track

Delete

big_bu 0 Pre-/append Black Frame:
) Sound Track
Add Empty Subtitle Track

¢ Subtitle Track
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In the dialog that will open up next you can select whether you want to
prepend or append to the reel you right clicked on. You can also select how
many frames/seconds of black frames you want to prepend/append.

Pre-/Append Black Frames X

Pre-/Append

@® Prepend

Duration

Display Time: 1 Unit:  Seconds

7.4  Adding Silence Sound

Timeline

As in the compositor it's also possible to add silence sound in the timeline.
When no clip is selected the silence track is added to the clip you right click on.
If you have selected a clip or multiple ones, the silence sound track will span all
of them. This will automatically be split up again into reels.

TEST FIRLF ENOUINT 51 4K NULL 20200121 NULSWPTI = 4 B @

0

§3 Picture Track

7.5 Timeline Validation

Every once in a while the current timeline is validated so you can see if your
project is valid and can be generated. In case of errors or warnings, a warning
symbol appears in the toolbar. Clicking it opens a popup containing detailed
information about what's wrong.
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8

Composition Marker

Composition Marker are marker carried in the Marker Track contained in the
Composition Playlist. They signal special events like the First Frame of End
Credits (FFEC) and are used for purposes like to automatically dimm the light in
theaters when the end credits roll.

A Composition Marker consists of a predefined Marker Label and Scope, an
optional and custom Annotation Text and the relative offset from the start of
the Marker Track the Marker is located in. This means in case of a Composition

with multiple Reels the offset may not represent the absolute position of the
Marker in the Composition.

Composition Duration: 200

Duration: 100 |1 Duration: 100
I

|
—
|
|

11

Reel 1 Reel 2

LFOC (Last Frame of CompositiorT)

| Offset: 99 |
| |

In this lllustration a Marker is located in the Marker Track of the second Reel.
The Marker Track has no Entry Point or an Entry Point value of zero. In this
case, as the start of the Marker Track and the Reel coincide, the absolute
position of the Marker in the Composition is defined by the start of the Reel
and the Offset of the Marker in the Marker Track. On the other hand, if a
Marker Track has an Entry Point value other than zero, the absolute position of
its Markers are further offset accordingly.
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8.1 Overview

If a loaded DCP or project contains Compositions with Marker, easyDCP
Creator will display the associated Marker Tracks. If the first Composition
Marker is added to a Composition, easyDCP Creator will automatically insert
the required Marker Tracks into the Composition. Likewise, if the last
Composition Marker is removed, the associated Marker Tracks in the
Composition will be removed as well.

File Edic Tra

[C) & Generate Package..

el sourd _FEN-XXINT_51_2K_NULL
Picture Track 1

>

H Picture Track 1

Sound Track 1 Sound Track 2
) 7 o)
. Marke e . Mari

Picture Track 2
L]
Sound Track 1

enus

r
easyDCP Plus

position Marker

All existing Marker will also be listed in the Composition Marker tab next to the
Metadata Inspector tab. This list is used for adding, editing or removing any
Markers as well.

8.2  Editing

8.2.1 Adding a new Marker

To add a new Marker the Reel, or in the Timeline View the Picture Clip of the
Reel, has to be selected the Marker shall be added to. By clicking Add in the

Label LFOC (Last Frame of Compaosition)

Scope

Description

Offset

Annotation

Cancel Add
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Composition Marker tab, next to the Metadata Inspector tab, the Composition
Marker dialog will open.

In this dialog one of the predefined Marker Label, the Offset in the Marker
Track and an optional Annotation can be set.

After confirming with Add easyDCP Creator will automatically create all the
required Marker Tracks if they do not exist yet and will add the new Marker.

8.2.2 Edit a Marker

Markers can be edited by selecting the Marker to be edited in the Composition
Marker tab and clicking Edit. This will bring up the same dialog as for adding
Marker prefilled with the current values for the Marker. After modification the

changes can be applied by clicking Save.

8.2.3 Remove a Marker

Markers can be removed by selecting the Marker to be removed and clicking
Remove. If the last Marker in a Composition was removed, easyDCP Creator
will also remove all remaining and now empty Marker Tracks from the

Composition.
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9

The Metadata Window

The metadata window shows the most important technical properties of
whatever item is currently selected. It is merely a read-only element and cannot

Metadata Ins

EE big_buck_bunny_00000

Picture 24000/1001 1920 x 1080 (1.78) XYZ (DCI)
ilung/Einzelbildsequenzen/)2C/bbb_kleine_DCI2K_j2c/big_buck_bunny_00000.j2c &
Property Value
UuID 5ca09373-cd7b-4e35 -c557a0257816
Target File Name 5ca0 3-cd7b-4e a0257816_video.mxf
Intrinsic Duration 01:18 (42 Frames)
Window In ):00 (#0), Out 00:00:01:17 (#41)

Duration 00:00:01:18 (42 Frames)

Property
Resolution 1920 x 1080 (1.78)
Bit Depth 12
lor Sampling  4:4:4
Codec JPEG 2000

JPEG 2000 Profile 2K Digital Cinema Profile

be used to change any of the properties.

The set of properties that are displayed depends on what item type was
selected:

e Track (picture, sound or timed text)

e Track in Reel (picture, sound or timed text)
e Reel

o Composition

The Metadata and Preview windows always refer to the same item.
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10 The Preview Window

In the preview window, you are able to take a look into each Picture and
Subtitle Track.

The previewed frame number is shown in white letters in the box on the
bottom right of the preview window (starting with 0). If you scroll to a position
before offset or after duration, this number will turn red.

By default, color processing will not be shown. To activate the color processing
preview, toggle the “Preview color transform” button next to the
frame number:

Preview

3 4666 - s

Preview color transform

When color processing is disabled, the source color space will be previewed.
When it is enabled, the configure Preview color space (see Settings => Preview)
will be used.

Color processing won't affect subtitle preview.

Preview for audio tracks is not yet supported.
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10.1 Safe Areas

Introduced in version 3.6.0, easyDCP Creator can overlay , Title Safe” and
LAction Safe” areas as well as the DCI containers Flat, Scope and Full.

. * TEST_FTR_F_EM-XG(_INT_531_2K_NULL_20201209_MUL_SMPTE_QV [DCP 2k/24FPS/SMPTE]

File Edit Track Cc io 2 Preview Vi

(& TEST FTRF EN-XX INT 51_2K NULL 2020|  Safefrea b

Tracks Timeline
Pi % Sound Subtitl
[E] Picture o} Soun e titles e

00:00:; AKFul

=

osuB ™

Each preset is based on an XML file that is located in a directory which can be
opened by selecting “Open Repository”. The “Title Safe”, “Action Safe”and
“Center” presets are defined by specifying coordinates relative to the image.
The remaining presets, on the other hand, are defined based on absolute
coordinates. Based on the presets it should be straight forward to add
additional custom presets, when required. They can either be copied into the
directory where they will be detected by easyDCP Creator after a restart or they
can be imported by selecting the “Add new preset...” option. The colors or
thickness can currently not be changed. The overlays cannot be burnt into the
image when exporting the DCP package.

Preview
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11 Generate a DCP

After adding content to compositions, press the “Generate Package..”
button in the upper right corner of the main window.

A wizard dialog will appear to guide you through the generation process. The
first page allows you to specify the destination folder for your package. It is
recommended to name the folder with your package title and select a folder on
an EXT-2 or EXT-3 formatted drive.

. Generate Package Wizard x

FTR_F_EN-XX_AL_51_2K_NULL_20210128_NUL_SMPTE_O' 'ﬂ

Recommended Folder Name: Test FTR F EN-XX AL 51 2K NULL 20210128 NUL

Reencoding

Default

Package Output

Re-encoding
For re-encoding a total of four options exist with different behaviors.

With the Force re-encoding option enabled, each source image file will be re-
encoded, regardless if the source files are JPEG 2000 codestreams (*.j2c files
and codestreams from MXF files) or not. This ensures that each final image will
have the right format (i.e. the correct DCI compliant profile, bitrate, color
gamut etc.).

Disabling force re-encoding option is only available in the full licensed version
of easyDCP Creator, since the easyDCP logo will be burned into each picture
frame at the top left. Thus, each picture has to be re-encoded.
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The force no re-encoding option causes the codestreams to be packed directly
into the final package. This may speed up the package generation process. The
user has to make sure that the source files are already in the right format. No
source file checks will be made, the source files will be copied directly into the
package and just the mxf file will be written.

The copy mxf option is similar to force no re-encoding, but doesn’t even
unpack the codestreams and just copy the whole mxf file. In this case even the
mxf metadata has to be correct.

Using force no re-encoding or copy source option you are responsible for
compatibility of the data with the selected package type in regards of
codec/profile, resolution, colors etc.

With the re-encode if necessary option selected easyDCP Creator doesn’t check
the input images if the input format is JPEG 2000 in terms of e.g. color space.
easyDCP Creator checks image dimensions, bit depth, bitrate and wavelets
only. Using this chain a user can create his own JPEG 2000 files in the post
production and easyDCP Creator will just do the faster packaging. The
advantage is that if any color processing is bypassed, packaging will be much
faster.

To ensure that JPEG 2000 codestreams will be directly copied into the final
package, the following settings must be done:

e All source files shall be DCI compliant JPEG 2000 codestreams.
e The JPEG 2000 codestream re-encoding shall be switched off.

e The pillar-/letterboxing & scaling shall be switched off (see 5.1.7
Letterboxing & Scaling).

e The source color space has to be XYZ.

Use JPEG 2000 Visual Weightings (CPU only)
Enable this option if you want to use visual weightings mechanisms in the JPEG

2000 encoding process. This settings only affects the package generation using
CPU and improves the image quality at low bitrates.
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Write AnnotationText nodes to Interop CPL

Some cinema projectors have problems when there’s more than one
AnnotationText in a CPL. For compatibility you can disable this option.

CPL Standalone attribute

Some cinema systems complain about standalone attribute in some metdata
files of the DCP being set to “yes”, but need to be “no”. The “Default”
behavior will add no standalone attribute at all, which is interpreted as “yes”. If
you need them to be set to “no” choose the “Force No” option.

Trim Track Files

Enabling this option causes unused frames being stripped from the mxf files.
This happens as pre-processing step of the generation and can reduce
generation time.

Example: Source sequence has 100000 frames, but just 1000 frames are
used in the package. As a result just these 1000 frames are encoded while
the remaining 99000 frames aren’t touched.

Force Wild Track Format

Some cinema servers require audio to use the wild track channel format instead
of the digitical cinema labels. While this can be already configured when
adding audio to the project (see 5.2.1) you can enforce wild track format by
checking this option. The configuration then will be overwritten to use wild
track format no matter what has been configured originally.

The next page allows specifying the maximum bitrate of the generated DCP.
250 Mbit/sec is the maximum bitrate for DCPs.
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. Generate Package Wizard >

Maximum Picture Bitrate

[0 Enable Higher Bit Rates

Min Quality 250 Mbps Max Quality

Image Processing
Bitdepth
Subsampling

Destination Color Space

. . [ ]
Quality Settings Step 2 of 4 <Back  Next>

Keep in mind that a lower maximum bitrate can decrease the picture quality of
the DCP.

If your package contains at least one encrypted Track, you can also choose a
DCP Digest and a KDM server certificate. Digest generation won't be available
when generating a supplemental DCP (see 11.2).

Destination Color Space

Select the color space your package shall be encoded to. For DCP that's always
XYZ, so the option can’t be changed.
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. Generate Package Wizard x
M-Generation)

Destination: h/MNVideos/TEST_FTR_F_EN-X0(_ INT_5 209 _NUL_SMPTE_OV.dcpdig

Destination Folder

Encryption Settings - <Back  Next>

FTR_F_EN-
5 _NUL_SMPTE_OV

Packaging Summary . <Back  Generate
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During the render process some statistics will be shown, like “Estimated Time
Left” or the current rendering throughput.

After the rendering process has finished the result will be shown on the last
page of the generation wizard. Please have a careful look if there were any
issues detected during the rendering process.

Here you also have the option to validate your project (see 14.5), open it for a
@

ate Package Wizard x

Rendering

1209_NUL_SMPTE_OV

(® Open in easyDCP Player BS Browse folder

Result
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11.1  Why does easyDCP Creator generate KDMs since version 2.1?

Beginning with version 2.1, easyDCP Creator
is capable of opening encrypted DCPs and
using these DCPs as basis for new DCPs.

There are basically two ways of providing
the keys in order to allow easyDCP Creator
to decrypt the content for the preview and
for generating a new DCP.

If keys are provided by means of a
proprietary Fraunhofer Digest file (*.dcpdig), Provide
you can generate and also save the package. Diges
In both cases a new digest valid for the
generated/saved package is created.

Open DCP

Provide
(D)KDM

Alter DCP

Generate DCP &
Save-Package

Open DCP

Alter DCP

Generate DCP &
Save Package

If one provides the keys by
means of Distribution KDM (or
KDM), easyDCP Creator does
not allow to save the package
as this would invalidate
existing KDMs. In every case
you need to generate a new package which will create a new
(D)KDM and digest for the new package.

Using easyDCP Creator version 2.1 or higher you can generate a
(D)KDM directly from within easyDCP Creator. The “Generate
DCP..."” dialog was extended to offer you to generate KDMs. By
design, one (D)KDM will be generated for easyDCP Creator itself
in order to make sure that one can open the DCP on the same
computer using easyDCP Creator later. A second (D)KDM can be
generated for another software being able to open (D)KDMs,
including easyDCP KDM Generator+ and many other 3rd party

hard-/and software tools.

11.2 Why can | not generate a Fraunhofer Digest file when generating DCP?

Since version 2.1 of easyDCP Creator it is possible to open encrypted DCPs and
to use these DCPs as a basis for new DCPs. There are basically two ways of
providing the keys in order to allow easyDCP Creator to decrypt the content for
the preview and before generating a new DCP.
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If one provides the keys by a Fraunhofer Digest, we assume that the user
generated the content and that he is in charge of the source content used for
the first DCP generation. In such a case you can do everything in easyDCP
Creator, including the deactivation of the encryption and the generation of a
new Digest when generating a new DCP.

If one provides the keys by a Distribution KDM (or KDM), easyDCP Creator does
not allow to generate the Fraunhofer Digest in case the source package is a
supplemental DCP. In order to understand this behavior we have to explain that
the Fraunhofer Digest stores the encryption key as plain text on the hard drive.
Without disabling the Digest-option one could easily open an encrypted DCP
together with a (D)KDM, generate a new encrypted DCP and store the
encryption keys in plaintext. Since content-owners are very diligent with their
content, Fraunhofer IIS decided to disable the option since version 2.1.

11.3  Why can | generate a KDM with easyDCP Creator? Do | still need the easyDCP
KDM Generator?

Please study the answer to the question “Why does easyDCP Creator generate
KDMs since version 2.1?" in order to learn, why easyDCP Creator (version 2.1
or higher) allows for the generation of (D)KDMs. Please notice that one can
only generate one (D)KDM when generating a new DCP. For the generation of
many KDMs, easyDCP KDM Generator is still the software of your choice
allowing you to generate unlimited KDMs with a simple click.
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12 Encrypting DCPs

Encrypted DCPs make sure that your content can only be played back on
specific servers. No one will be able to read the unencrypted data.

Every single Track (i.e. picture, sound or subtitle) can either be encrypted or
unencrypted. So you have the ability to only encrypt the pictures, while the
sound is unencrypted or vice versa. Another possibility is that you encrypt all
reels of a single composition except the first reel so that the first reel (e.g. a
trailer or advertisement) can be played back on every d-cinema server while the
rest of the composition can only be played back with the right KDM.

Subtitle encryption is only supported in SMPTE mode.

12.1  Encrypting Tracks
To encrypt your DCP, just do the following steps:

Step 1: After loading the image Tracks, you can switch the encryption on or off
by clicking the right mouse button, when rolling over the Track and selecting
the menu item “Encryption” on or off. A lock appears on the Track, when
encryption is activated:

Tracks Timeline
£% Picture o3 Sound () Subtitles TEST FTR.F

00:00:00:00

This Track

Silence for: big_buck_bunny
o

Enable for all Picture Tracks
Silence for: big_buck_bunny Enable for all Tracks

O s F

3 Sound Track

Step 2: When switching encryption on, easyDCP Creator generates
automatically a random AES128 key.

Step 3: After pressing the “Generate Package...”button, a menu appears. Here
you should create a DCP Digest file (*.dcpdig) selecting the checkbox and
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choosing a folder). The DCP Digest is an XML file, which contains the AES keys
for further KDM generation. Now the encrypted DCP can be generated.

WARNING: Do not deliver this DCP Digest file to any exhibitions
because the DCP Digest contains all the keys in plain text needed to
decrypt your DCP.

Step 4: For the creation of KDMs we will deliver a separate KDM-Generation
tool. This tool will read the DCP Digest file with the AES keys create KDMs for
the specified player systems.

12.2 Server Certificates

easyDCP Creator allows loading encrypted content. Each Digital Cinema play-
out system or mastering station has its own private and public key, and so does
each easyDCP Creator installation. The private key is known only to the play-
out system, whereas the public key is contained in a public server certificate
and may be distributed to content providers. When content providers choose to
encrypt a DCP, they need to somehow provide the decryption keys (there is one
key for every encrypted track file) to the play-out system. To ensure that no one
else is able to read these sensitive decryption keys, they are themselves
encrypted in a way that only the targeted play-out system is able to decrypt
them. To do this, the content provider will need the play-out system’s public
server certificate. This encrypted message is called a Key Delivery Message
(KDM). easyDCP Creator will not keep its ingested KDMs in a repository, so that
encrypted DCPs can only be viewed multiple times while having to re-ingest the
keys each time. An expired KDM will no longer grant access to the DCP.

When easyDCP Creator is first started, it does not yet have a server certificate
set. The demo edition does not allow unlocking of encrypted content. Only in
the commercial edition, server certificates can be requested from Fraunhofer
support by clicking “menu bar -> File -> Settings -> Activation Status ->
Request License & Certificates”. The process is described in a screen cast at
www.easydcp.com.

Unique private and public keys will be generated and provided to you online.
The received license and certificate set (a Zip file) can be imported via drag &
drop (or with ,, menu bar -> File -> Settings -> Activation Status -> Import
License & Certificates”.

The certificates are created and signed by Fraunhofer IIS. Fraunhofer IIS will
delete the private key immediately, and keep the public leaf certificate in a
database. The certificate is digitally signed by a chain of Fraunhofer certificates.
These certificates are referred to as a certificate chain and this certificate chain,
even though already included in the public server certificate, is additionally
saved in a separate file. These certificates are meant for commercial use as they
state the licensee’s URL and have a unique serial number that links the
certificates to the license. These server certificates are tied to the licensee’s
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computer, using the easyDCP system hash. If the license should need to be
migrated to another system, a new certificate set will have to be requested. A
migration is possible in the user account at www.easydcp.com. Since the
private key is very sensitive, it is asynchronously encrypted using a combination
of easyDCP Creator internal keys and a password selected by the user during
the License & Certificates request. Likewise, if the user chooses to store their
password, it is first asynchronously encrypted. The user password needs to have
6 to 20 letters and cannot be changed after it was created.

All mentioned files are stored in the user application data folder’s certificates
subfolder. Hence, the OS user management can be used to maintain multiple
sets of certificates simultaneously. In order to easily determine which files
belong together, they are each identified by a unique ID. The ID of the set that
is currently used by easyDCP Creator is also listed in the “About” dialog (hit
'F6').

e easydcpcreator_<ID>.privkey.pem contains the encrypted private key
e easydcpcreator _<ID>.cert.sha256.crt is the public server certificate
e easydcpcreator _<ID>.chain.sha256.pem contains the certificate chain

e easydcpcreator _<ID>.privkey.passwd contains the encrypted user
password

When easyDCP Creator is uninstalled, none of these files will be removed. If the
user password file (*.passwd) is manually deleted, the user will simply be
prompted for the password again the next time a KDM is ingested or an
encrypted DCP is opened.

12.3 Export Server Certificates

The content decryption context menu is only available in the easyDCP Creator
edition.

The option “File -> Content Decryption -> Export Public Server Certificate” will
copy both the public leaf certificate (easydcpcreator_<id>.cert.sha256.crt) and
the signature chain (easydcpcreator _<id>.chain.sha256.pem) to the selected
folder. The signature chain contains the leaf certificate as well as intermediate
certificates and the root certificate. You may safely distribute these certificates
to content providers who want to issue a Distribution KDM to your easyDCP
Creator installation. When issuing (D)KDMs with easyDCP KDM Generator,
place only the leaf certificate file (*.crt) into the server certificate’s folder or just
drag and drop it into the corresponding input form.
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13

13.1

Signing DCPs

easyDCP Creator allows you to sign the package with your own digital
certificates. Note: If you generate DCPs with one or more encrypted Tracks, the
package shall be signed.

Signing a DCP

To sign a package, open the Signature dialog by choosing “menu bar -> File ->
Settings -> Activation Status -> Signature Setup”. The following dialog box
should appear:

@ ontions s

word will be save

CP Creator+/Weblicensi

Add Signer Public Certificate... Remove Certificate

OK Cancel Apply

This dialog will automatically be filled with demo signer certificates during the
first startup. If you purchase a license, you will receive your own signer
certificates, containing your company’s URL.

Custom signer certificates can also be used. Check the Checkbox “Signature
Enabled” and fill out the window “Certificate Chain to be included” with the
entire certificate chain of your own signer certificate (including the self-signed
root certificate). There should be a minimum of 3 certificates in the certificate
chain. The signer certificate (leaf certificate) should not be included here. Enter
a Signer Certificate File with your own private RSA key file. If your private key
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file itself is encrypted (which is strongly recommended), enter the password for
this key file, otherwise leave this field empty.

To make sure all certificates and the certificate chain is valid please refer to the
documents “SMPTE 430-2 D-Cinema Operations: Digital Certificate” and
“Compliance Test Plan”, which you can find at http://www.dcimovies.com/. It
is very important to fulfill these specifications, otherwise problems may occur
during ingest or playback of the package.
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14 Opening DCPs

With the function for opening packages the easyDCP Creator provides a
powerful feature to apply changes to existing DCPs fast and easily. With this
function you are able to open your own DCPs or third party DCPs and deploy
any changes e.g. adding subtitles, adding sound tracks, adding and rearranging
reels and so forth.

14.1 Editing an opened DCP

An opened unencrypted DCP can be edited just like a DCP that is built from
scratch. Some restrictions apply on encrypted DCPs (see below). It is also
possible to save the opened DCP and the deployed changes as a Project
(*.dcpproj) in the easyDCP Creator. From the edited DCP, you can then
generate a new DCP or a supplemental DCP.

14.2 Saving an opened package

When you have opened a package and just make changes on the metadata of
the package, you don’t have to generate a new package, you can also just save
your changes to the existing one. Changes of the metadata include the offset,
duration and annotation text of reels, rearranging, deleting and adding reels,
renaming, deleting and adding compositions. To save the changes, choose
“Save Package” in the file menu. If saving is not possible and re-encoding of
the whole DCP is necessary, an error message will appear.

When saving the DCP, new UUIDs for all compositions and reels and the
packing list will be generated. Thus, the saved DCP will be distinguished from
the original by D-Cinema servers. If you saved an encrypted DCP, the DCP-
Digest (*.dcpdig) file will be overwritten. Old KDMs for this DCP won't work
anymore, new KDMs need to be generated.

If you change the Tracks of the package, e. g. applying a color transformation

or add new Tracks, you have to generate a new DCP or a supplemental DCP
using the button “Generate Package...”.
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14.3 Supplemental DCPs

Generating a feature movie is a time expensive procedure. If you're just adding
subtitles or an additional sound track to an existing movie, easyDCP Creator
provides a solution saving you a lot of time. You can generate a supplemental
DCP. A supplemental DCP is a DCP, which enhances or modifies an existing
DCP by providing just the changes and using the Tracks of the original DCP as
references. Hence you don’t have to build a whole DCP when just adding
material to an existing one. Because a supplemental DCP amends an existing
DCP, both the original DCP and the supplemental DCP have to be ingested on
a D-Cinema Server to playback the compositions of the supplemental DCP.

To generate a supplemental DCP with easyDCP Creator you have to open a
DCP and mark the original track and subtitle files as references (supplemental).
For that, you have to click with the right mouse button on the Track and select
“Supplemental -> This Track” in the displayed menu:

Tracks Package Content

E Picture % Sound ¢ 3 Subtitles

H tos_video.mxf

Delete

tos_audio.mdf
*,)) ~aueie.m Duplicate Ctrl+D
Add Silence Sound Track Ctrl+M
Add Empty Subtitle Track Ctrl+5hift+Y

rames from MXF...

Encrypt
Supplemental This Track
Enable for all Picture Tracks

Enable for all Tracks

Then new compositions and new Tracks can be added and changes at existing
compositions can be applied.

By clicking on the “Generate Package...” button the supplemental DCP will be
generated. The difference to a normal DCP is, all Tracks marked as reference
are not packed into the supplemental DCP, they are only referenced by CPL(s).
This saves disk space and time during the generation process of the DCP.

With the easyDCP Creator it is even possible to open and edit supplemental
DCPs and generate further supplemental DCPs to them.
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14.4 Opening encrypted DCPs

14.5 Validator

Opening encrypted DCPs is a feature of the easyDCP Creator only. When you
open an encrypted DCP where you also have the corresponding Digest file
(*.dcpdig), you can perform any changes you want on the DCP. This way you
can open and modify encrypted DCPs you have built yourself. Without the
Digest you can’t change the DCP. If you have a KDM for the DCP you can view
its content in the preview window. An opened encrypted DCP shows a closed
lock on the encrypted Tracks, indicating that you have no access to this
content.

If you have the DCP-Digest file (*.dcpdig) or a KDM for the DCP, you can either
load it via the file menu or directly drop it onto the track manager to gain
access to the encrypted content.

After you have loaded a KDM or Digest, an opened lock is shown with the
Tracks denoting your access to its content. With a Digest file loaded, you can
apply any changes on the DCP and save it or generate a new or supplemental
DCP. Without a Digest, you can only generate supplemental DCPs.

When generating a supplemental DCP from an encrypted DCP, new KDMs for
the supplemental DCP have to be generated.

The package validation module was introduced with easyDCP Creator 3.4. It
can be used to automatically search for a range of potential issues in a DCP.
The validation is split up into many individual tests. Tests are executed one after
the other. Some tests only take a split second (for instance: check if all files
exist) while others may take a while (for instance: check if all JPEG 2000 images
can be decoded).

Once a test was executed, it gives a result that is either Success, or
Failed. When selecting a test, more details can be found in the bottom section
of the validation dialog. A tree of events will describe what the test has done
and each entry in the tree can in turn be selected to see its details in the dark-
grey text edit below. It is often not possible to foresee whether an issue will
cause the DCP to be rejected by a cinema server or another tool in the
production chain. For this reason we encourage the user to even take warnings
seriously.
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@ Pscksge Validator X

y:  bt-movies02/TestSequenzen/Formatesammlung/Packages/DCP/DCP 4K TearsOfSteal Test 20s - easyDCP Validation Repnn.h‘mll -|&

Enable All Disable All

Name Description

ital signature

Timestamp

Cancel

The result of a validation run is always stored as a report in HTML format. By
default, the file will be named after the folder that contains the DCP and be
located next to it. Also, the overall test result will be included in the file name:

DCP: C:\MyDcps\AliceWonder FTR-1_S EN-LAS US-13 51 2K DI 20060607_TDC_OV\
Report: C:\MyDcps\AliceWonder FTR-1_S EN-LAS US-13 51 2K DI 20060607_TDC_OV -

easyDCP Validation Report (Success).html

By clicking the cogwheel icon next to the “Save Results to Directory” field, the
default behavior can be changed so that the file be located inside the DCP
directory and/or that the overall validation result not be included in the
filename.

DCP: C:\MyDcps\AliceWonder FTR-1_S EN-LAS_US-13_51 2K DI _20060607_TDC_OV\
Report: C:\MyDcps\AliceWonder FTR-1_S_EN-LAS_US-13_51 2K DI_20060607_TDC_OV\
AliceWonder FTR-1_S EN-LAS US-13 51 2K DI 20060607_TDC_OV - easyDCP

Validation Report.html

The validation report is separated into seven sections:

e General Information — contains top-level metadata on the package,
the test result and the computer and easyDCP version where the
validation was carried out. Custom annotations that the user entered
into the validation dialog’s “comment” field will also be added to this
section.
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e Composition Playlists — lists technical properties (such as duration,
resolution, package type, JPEG 2000 profile, audio layout, etc.)
individually for each composition.

e Quality Report — contains all the test results and details in an
interactive view

¢ Recommendations — contains all the test results that are compliant to
the standard but can cause issues in cinemas

e JPEG 2000 Bitrate Analysis — contains an interactive plot of the
bitrate in Mbit/s over time for each CPL. Additionally, some statistics
such as peak and average bitrate or the time code of the largest frame
are stated.

e Files - lists the content of each XML file as well as the metadata of
each MXF file in the package. If the package is a supplemental package
(version file - VF) and the original version (OV) was also loaded, both
packages' files are listed.

e Directory Snapshot - lists of all files (including those that don’t
belong to the package) within the folder or any subfolders of the
package, including the file's size in Bytes and date of its last
modification. Paths are stated relative to the package’s root folder so
that names of the user’s local or network repository are not disclosed.

4
easyDCPPIus  yajidation Report for "DCP 4K TearsOfSteal Test 20s"

~ General Information

Validation Result PackageName  DCP 4K TearsOfSteal Test 205 Validated with easyDCP Creator+ 4.0.0 (x64)
. Package Type Digital Cinema Package 4k Computer Name up1235
Warning User Annatmion Operating System  Windows 10(10.0)
Validated on 2020-12-09T14:47:03
. EmDe c Validation took 00:00:16
Warning: 1
Recommendations: 2
Skipped (total):
Skipped (by user):
Encrypted:

i
L]
a
Successful: 46
Totak: 78

Validation result is "Warning", because 1 test was finished with "Warning". There are 2 recommendations available.

+ Composition Playlists

+ Quality Report

+ Recommendations

+ JPEG 2000 Bitrate Analysis
+ Files

+ Directory Snapshot

The overall result of the validation is

e Failed - if at least one test found an error
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o , if at least one test found a warning or has been deliberately
disabled by the user (by clicking the check box next to the test in the
validation dialog), and no test found an error

e Success — if all tests were executed and none of them found any
potential issues (warnings or errors)

The quality report shows the results and details of all tests. When selecting a
test, details are shown in the dark grey box on the bottom. In the below
example, the test result is a warning, because the tests was deliberately
disabled by the user by deselecting it before the start of the validation.

The Bitrate Analysis tab gives information on the JPEG 2000 bitrate. Every
DCP or IMP is subject to a maximum bitrate that should never be exceeded. The
maximum is typically 250 Mbit/s for DCPs, but can be higher for high-bitrate
DCPs. The maximum bitrate is independent of the resolution or whether the
movie is in 2D or 3D. easyDCP Creator will infer the maximum bitrate based on
the package type and JPEG 2000 profile.

JPEG 2000 is a highly data-dependent image compression scheme, though. If a
particular image is easy to compress, e.g. because there are not a lot of details
in it, then the maximum bitrate will not be reached. Only images with many
details (or a lot of noise) will have to be capped in order not to exceed the data
rate. The bitrate computed by easyDCP is based only on the size of the
decrypted JPEG 2000 file (i.e. without MXF overhead) and is converted from
bits to Megabits using 10° (1000) as demanded by the specifications - and not
2'9(1024).

Starting with easyDCP 3.7.0 the bitrate analysis also shows the bitrates for each
of the three components. For DCPs the component bitrate is limited at 200
Mbit/s. Since this can lead to issues on some cinema servers, the validation will
show a warning between 190 to 200 Mbit/s for a component.

The diagram plots the bitrate over the time for each CPL. The plot is zoom-able

via the mouse wheel and can be moved left or right by dragging it with the left
mouse button pressed.
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The validation can also be triggered from the command line. This way it is also
easy to batch-validate an existing collection of DCPs.

Below is an example of Windows Batch file for validating all DCPs in a given
folder:

@echo off
pushd \\networkstorage\MyDcpRepository
set EasyDcpBin=C:\Program Files\Fraunhofer IIS\easyDCP Creator+ 4.0.0\bin\easyDCP

Creator+.com

for /f "tokens=*" %%D in ('dir /S /B /A:-D assetmap*') do (
echo Validating %%D
echo.
"$EasyDcpBin%" "%%D" -validate -o C:\\Reports
echo.
)
popd

For more details on how to use easyDCP Creator from the command line,
please refer to chapter 15.

14.6 Merge CPLs
easyDCP Creator can merge CPLs from other DCPs or complete other DCPs into
the currently opened project. Via Package => Merge CPLs the file, either the
ASSETMAP or the CPL XML file, can be selected. The CPLs of the selected
package will be added to the active project. In case of matching track files (e.g.
when adding a VF to the OV) the track files are automatically reused.
There currently are some limitations for the import process:

e Project types have to match: you can’t import an IMF package into
easyDCP Creator

e Framerates of the packages have to match
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15 Using Scripting Functionality

easyDCP Creator can be used with command line arguments. Using easyDCP
Creator with command line arguments can be very useful for scripting purposes
or in a scripting environment where many operations have to be executed
automatically. For example this can be a weekly advertisement where the
workflow is always the same. Or maybe you want to create a bunch of DCPs all
with the same picture but with a somewhat different sound to find out which

is the best.

15.1 On Windows

On Windows, the command prompt or a script (e.g. a batch file) would
typically be used to pass command line parameters to easyDCP Creator.
easyDCP Creator.exe / easyDCP Creator.exe were built using the Windows
Subsystem and therefore their output is not visible in the command prompt.
Instead, easyDCP Creator.com / easyDCP Creator.com should be used. Since
the executable file contains a space, enclose any calls into “”, e.g.

C:\>"Program Files\Fraunhofer IIS\easyDCP Creator+ 4.0.0\bin\easyDCP
Creator.com” —help

15.2 On MacOS X

On Mac OS X, the terminal or a script (e.g. a shell script) would typically be
used to pass command line parameters to easyDCP Creator. The easyDCP
Creator application is in truth a directory called “easyDCP Creator+.app”. The
executable file which can be started and get passed parameters is “easyDCP
Creator+.app/Contents/MacOS/easyDCP Creator”. Since the executable file

"

contains a space, enclose any calls into “”, e.q.

Mymac:~ user$ “/Applications/easyDCP Creator+
4.0.0.app/Contents/Mac0OS/easyDCP Creator 3.7.0” -help

15.3 Using command line (CLI) arguments

For detailed descriptions of the available parameters, call the executable file
with the parameter “—help”.

C:\Program Files\Fraunhofer IIS\easyDCP Creator+ 4.0.0\bin>"easyDCP Creator+.com" -h
easyDCP Creator+ 4.0.0 rev.105190

Usage: " C:/Program Files/Fraunhofer IIS/easyDCP Creator+ 4.0.0/bin/easyDCP Creator+.exe"
<parameters> "

Optional parameters:

-username Login username - optional if already stored
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-password Login password - optional if already stored

-i <projectfile>
-0 <output directory>
-mbits <mbits> optional - set mbits per second for encoding.
Default: 250 mbits for DCP
-d <digest filename>
-p <password for signature certificate private key>
-writeCplMetadata Set CPL metadata writing enabled
This setting will be taken into account for SMPTE DCPs only
-trimTrackFiles Set Track File trimming enabled
This setting will cause mxf files to only contain used ranges of
frames
-forceReencoding Force re-encoding of sources
All frames get re-encoded
-forceNoReencoding Force no re-encoding, just re-wrapping

No frames will be re-encoded and the frames will be packed into a
new mxf file
You have to make sure that the content properties are valid for
the selected package type (profile/codec, bitrate, color space).
-reencodeOnDemand Re-encode if necessary
Only frames that don't match the target settings (profile/codec,
bitrate, color space) get re-encoded.
All other frames will be packaged as they are.
-copySourceFiles Copy mxf files to destination without touching sources
No frames will be re-encoded and the existing MXF files will be
copied to the destination folder.
You have to make sure that the content properties are valid for
the selected package type (profile/codec, bitrate, color space).
-forceWildTrackFormat Enforce wild track format for the package (Audio)
No matter what the originally configured audio channel format is
wild track format will be used.

-ph print system hash (required for requesting a license)
-log <logfile>|CON|CONSOLE

enable log and write it to a file or the console
-h print this help

Device management:
Select which devices should be used for generation

—deviceCpuOnly Use only CPU for generation
—deviceGpuOnly Use most powerful GPU for generation
—deviceld <device ID>

Use specific GPU, identified by device id

CUDA devices:
[1] [CUDA] "GeForce RTX 2080" (cc7.5, 46 x 128 processors, 8192 MB)

Example:
C:\Program Files\Fraunhofer IIS\easyDCP Creator+ 4.0.0\bin\easyDCP Creator+.exe -i
C:\myDCPprojs\test.dcpproj -o C:\myDCP\newDCP -d C:\MyDigests\newDigest.dcpdig

Validation parameters:

-validate
Performs a validation of the provided package.

[--reportFile|-o <report.html>]
Sets the path for the output file of validation. The directory has to exist.

If the path is a directory, the package's folder name will be used as file base name.

This way, all reports for a validation batch job can be conveniently stored in a
single folder.

[-—comment |-c <comment>]
Write a custom comment to the quality report.

[--tests|-t <"1,2,3">]
List of tests which should be executed. If no tests are selected, all available tests
will be executed.

Mutually exclusive with -skipTests.

[--skipTests|-s <"1,2,3">]
List of tests which should not be executed. All other tests will be enabled.

Mutually exclusive with -tests.
Available tests:

Id Name
1 File Sizes
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XML Schema
File Hashes
File Hashes (small fi
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JPEG 2000 Bit Rate
Audio Buffers
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Package Title
Consistent Trackfiles
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Fonts/PNGs Listed in
Out of Bounds Timesta
Characters Available
Fonts/PNGs Available
Order of Time-in Time
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Audio Bits

JPEG 2000 Properties
Number of Sequences/T
Sequence Durations
Sequence Edit Rates
Subtitle Burn-in
Subtitle Display Type
Subtitle Language
Subtitle Multi Usage
Dolby Atmos

Sequence Duration

Audio Sequence Duration with NTSC Frame Rates

Number of Entries
Sound Language Code
Intrinsic Duration
Frame and Edit Rate
Frame and Edit Rate M
Picture Track Subsamp
Resolution

Track audio padding
Subtitle Track Source
Subtitle Track Confor:
Subtitle Track Schema
Subtitle Track Semant
Subtitle Track Edit R
Subtitle Track Resour
Subtitle Track Encryp
Subtitle Entries Afte
Frame Rate Conformity
Subsampling Resolutio
Dolby Vision Metadata

Dolby Vision Metadata Supplemental
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Check for valid CPL m

Check for CPL metadata extension sign language video
JPEG 2000 Component Bit Rate Recommendation

Package
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15.4

Examples

90 Subtitle Track ReelNumber
91 SMPTE Subtitle Namespace Prefix

easyDCP_Creator "c:/myprojects/Africa.dcpproj"

Starts easyDCP Creator and automatically opens the Project File
"c:/myprojects/Africa.dcpproj”

easyDCP Creator -i “c:\DCPproj\test.dcpproj” -o “c:\DCP”
-d “c:\digests\new.dcpdig”

Creates a DCP into the folder “c:\pcp” using the Project File “test.dcpproi”
and generates the DCP Digest file “new.dcpdig”

15.5 Standalone Transcoder

The standalone transcoder application can be used in the same way as
described for easyDCP Creator above. Starting easyDCP Standalone Transcoder
with the parameter “—help” will display a list of available parameters.

C:\Program Files\Fraunhofer IIS\easyDCP Creator+ 4.0.0\bin>"easyDCP JPEG 2000 Standalone
Transcoder.com" -h

Usage:
C:\Program Files\Fraunhofer IIS\easyDCP Creator+ 4.0.0\bin\easyDCP JPEG 2000 Standalone
Transcoder.exe

—-input /-1 <input file>

[-start /-s <start frame> ]
[-end /-e <end frame> ]
-output /-0 <output folder>

[-subfolder /-sf

[-type /-t <project type> ]
[-fpsnum /-f <fps numerator> ]
[-fpsdenom /-d <fps_denominator> ]
[-bitrate /-b <bitrate> ]
[-letterboxing /-p <letterboxing> ]
[-scaling /-sc <scaling> ]
[-colortransform /-c <color_transformation> ]
[-sourcecolorspace /-ss <source_color_ space> ]
[-destinationcolorspace /-ds <destination color space> ]
[-numthreads /-n <number_ of threads> ]
[-log <log_file path> ]
[-gui /=g 1
[-help /-h ]
[-username <username> ]
[-password <password> ]
<input_file> First input image or the movie file.
<start_frame> First frame which will be processed.
(Default: 0)
<end_frame> Last frame which will be processed.

(Default: last frame)
<output_folder> Output folder.
-subfolder / -sf Create subfolder with name based on the input file name.
(Default: Don't create subfolder)
<project_type> Type of the project and images.
Options: DCP2k, DCP2k3D, DCP4k, DCP4k3D, IAP2k, IAP4k, MAP
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(Default: DCP2k)
<fps_numerator> Numerator of frames per second.
(Default: 24)
<fps_denominator> Denominator of frames per second.
(Default: 1)
<bitrate> Bitrate for the JPEG 2000 compression in MBit/s or lossless:
60 - for 60MBit/s,
lossless - lossless compression
If project type is stereoscopic, the given value is
the overall bitrate for both eyes.
<letterboxing> Letterboxing applied.
Options: full, flat, scope, automatic and off
(Default: automatic)
<scaling> Scaling applied.
Options: off, fit, fill
(Default: off)
<color transformation> Color transformation, name or filename.
(Default: None)
<source_color_space> Color space of source, name or filename.
(Default: None)
<destination color space> Color space of destination, name or filename.
(Default: None)
<number of threads> Number of threads used for the processing.
(Default: maximum)
<status_xml_ output> Output will be send to a file or the serverport.
When given a path and file name, the status will be written to
that file. When given a server port number, the status will be
available at the given port.
<status_stylesheet file> Path and file name of the stylesheet, used with the
status xml.
When using a xml file output, the path has to be given
relatively to the status xml file. When using the server output
the path has to be given relatively to this program.
<status_stylesheet file> Path and file name of the stylesheet, used with the
status xml.
When using a xml file output, the path has to be given
relatively to the status xml file. When using the server output
the path has to be given relatively to this program.

<log file path> Path where log file shall be created ot "-"/"Con" for console logging
-gui/-g Force start of gui.

<username> Login username to connect to easyDcp license server

<password> Login password to connect to easyDcp license server

Available color transforms:

ITU 709 (Gamma 2.2) -> X'Y'Z"

ITU 709 (Gamma 2.4) -> X'Y'z'

P3 -> X'Y'Z'

R'G'B' Full Range -> Y'Cb'Cr' Legal Range (Rec BT.709

Available color spaces:

Eclair Color

RGB (ITU-R BT.2020 / PQ)

RGB (ITU-R BT.2020 / PQ) - Full Range
RGB (ITU-R BT.709 Full-Range)

RGB (ITU-R BT.709)

RGB (ITU-R BT.709) Legal Range Gamma
RGB (ITU-R BT.709) Legal Range Gamma
RGB (ITU-R BT.709) Legal Range Gamma
RGB (ITU-R BT.709) Legal Range Gamma
RGB P3 (D65)

RGB P3 (D65) PQ

RGB P3 (DCI)

Standard RGB (sRGB)

XYZ (DCI)

YCbCr (ITU-R BT.709

NN NN
oW N O
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16  Tips and Tricks handling DCPs

16.1

Uploading DCPs and KDMs to FTP-Servers

Before up- or downloading DCPs or KDMs to or from FTP-Servers, the DCPs
and KDMs should be zipped. During the upload or download process files
which are stored in ASCIl format — such as the XML files like Packing List (PKL),
Composition Playlist (CPL) or Key Delivery Message (KDM) — are changed and
errors may occur during DCP ingest or playback. Some FTP-Servers change line
feeds or tabs resulting in bad signature hash values. Mac and Windows often
use different line feed in text files. To prevent this source of errors before
transferring such data all files should be zipped before transaction. You should
zip files for E-Mailing, too.

A single DCP should consist of at least five files:

VOLINDEX or VOLINDEX . xml The volume index is important if you
deliver your DCP over more than one volume.

ASSETMAP or ASSETMAP. xml The Assetmap contains a list with all of the
files to find for the server.

«_pkl.xml A packing list (PKL) containing a list with all of the files to be
ingested.
w_Cpl.xml A composition playlist (CPL) containing information of a

single composition.

v J2c.mxf A Track containing JPEG 2000 pictures.

._pcm.mxf A Track containing PCM waveform.
w_sub.mxf A Track containing timed text.
w_kdm.xml A KDM for a specific D-Cinema playback system.

There may be more files regarding to the complexity of your package.

Every single DCP shall be stored in its own directory. No more than one DCP
shall be stored in one folder.

16.2 Opening XML files in text file editors

Opening XML-files of a DCP (e. g. PKL, CPL and KDM) in a text editor is a
dangerous thing. After opening the files for viewing please make sure you do
not save the files. Do not simply edit the XML-files. For example if you want to
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change your company name or correct a typo error you have to recreate the
whole DCP. One changed character is enough to fail the signature test and
errors may occur during ingest or playback of the DCP on a D-Cinema Server.

Some editors are running in auto-save mode thus overwriting the original files
(i.e. changing line delimiters due to the specific operating system) resulting in
bad signature hash values. These corrupted signatures cannot be ingested on a
D-Cinema playback system. So don’t touch the files of a DCP. Do not rename
any files of the DCP. Only store one DCP in its own folder. Two or more DCPs
cannot be stored in the same folder, because the assetmap.xml and the
volindex.xml will be overwritten.
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17  Limitations

17.1 DCPs
DCPs split across multiple volumes (Volindex) are not supported.
“E-Cinema” DCPs with MPEG2 essence are not supported.
17.2 Timed Text

The timed text formats specified for InterOp DCPs and SMPTE DCPs are
supported.

Only a subset of the elements defined in DLP Cinema™ Projection Technology
(“InterOp timed text”) and SMPTE 428-7 (“SMPTE timed text"”). This subset
covers PNG as well as text subtitles or captions, rendered horizontally with or
without custom fonts, outlines or shadows. A not exclusive list of ignored
elements are ruby characters (Rt tag), attributes related to rotation, attributes
related to scaling, attributes and related to stretching.

Stereo 3D subtitles are not supported.
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18  Frequently Asked Questions (FAQs)

please refer to FAQs at www.easydcp.com
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http://www.easydcp.com/

19 Contact

We appreciate very much to have your feedback and your annotations about
easyDCP Creator+. In order to enhance the software and to optimize it for your
applications, we are looking forward to your cooperation.

If you have any problems or questions, please contact us at the following
addresses:

Sales & Technical Support

easyDCP GmbH
Eiblwiesweg 2

82418 Murnau, Germany
info@easyDCP.com

Product Management

Fraunhofer Institute for Integrated Circuits IS
Department Moving Picture Technologies
Heiko Sparenberg

91058 Erlangen, Germany
heiko.sparenberg@iis.fraunhofer.de
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